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S5 EDITORIAL

This magazine was created using :

WELCOME TO THE LATEST ISSUE OF FuLL CIRCLE o’ SCRIBUS / ‘—
ow, 2026 already! Where did 2025 go? To bring in 2026 we bring you some Latex, Godot, /* (e A J

Inkscape and a sprinkle of LibreOffice.

For our reviews this month we're going with Edubuntu (remember that?) and the latest release
of Pop!_OS. | haven't heard of Edubuntu in a while, but it looks like it's back and under new
management.

LibreOffice

The Document Foundation

Elsewhere, Erik is having another rant, | mean opinion, and is answering your questions in the

ever popular Q&A section. He's also writing the C&C piece too. He's a busy guy. -
Remember: the Full Circle Weekly News is available on Spotify and YouTube. The more upvotes Find Full Circle on: ’
and reviews you give it on those platforms the more exposure we get. And, we have a Table of @) facebosekecormy
Contents which lists every article from every issue of FCM. Huge thanks to Paul Romano for Falteireterragazine
maintaining: https://goo.gl/tpOKgm and, if you're looking for some help, advice, or just a chinwag: : . _
remember that we have a Telegram group: E twitter.com/#!/fullcirclemag
https://t.me/joinchat/24ec1o0MFO1ZjZDcO0. | hope to see you there. Come and say hello. _
https://mastodon.social/
@ @fullcirclemagazine

All the best to you and yours for 2026!

Ronnie
ronnie@fullcirclemagazine.org E - E Weekly News:

\ https://fullcirclemagazine.ora/
@88 podcasts/index.xml

https://open.spotify.com/show/
E 6JhPBFSm6cLERGSbYsGarP @

n https://www.youtube.com/playlist?
list=PLnvOU8WOzXu4874qi5I2|sf- |

rQEyKPAIf !
full circle magazine #225 @ 3 h contents #
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ORBITINY DESKTOP

ENVIRONMENT:
29/12/2025

he eighth release of the

Orbitiny Desktop desktop
environment, written from scratch
using the Qt framework, has been
published. The project attempts to
combine innovative ideas
previously unseen in desktop
environments with traditional
elements, such as a plugin-enabled
panel, an application menu and a
desktop where shortcuts can be
placed. Work is currently focused
on running in X-server-based :
environments, but Wayland support :
is possible in the future. The code is
written in C++ and is licensed under
the GPL.

Orbitiny-specific features

- include: invoking actions via screen
ggstures (drawing a specific outline . ENGINE AND DURDEN 0.6.3
© with the mouse on an empty area of :
- the desktop); icon labels (shown for :
- new, modified, empty, or clipboard- :
- moved files, as well as empty

- directories); the ability to paste a

- file into multiple selected :
- directories simultaneously; support :
. for placing desktop contents in any
- directory (not just SHOME/

- Desktop); and the use of separate

- desktop directories for each virtual
- desktop and monitor. A list of

© typical Orbitiny features can be

- found in the previous

- announcement.

Submitted by ErikTheUnready

https://www.reddit.com/r/linux/

. comments/1py5avz/

. orbitiny desktop pilot 8 release t

. he_biggest and/

ARCAN 0.7.1 DESKTOP

Arcan is not tied to specific

. graphics subsystems and can run on

DESKTOP ENVIRONMENT
29/12/2025

various system environments (BSD,
© Linux, macOS, Windows) using

- pluggable backends. For example, it

fter a year of development, the :
Arcan 0.7.1 desktop engine has
been released. It combines a display :

- server, a multimedia framework and :
: a game engine for 3D graphics. :
- Arcan can be used to create a

- variety of graphics systems, from
- user interfaces for embedded

- applications to self-contained

- desktop environments. The

- Safespaces 3D user environment
* for virtual reality systems and the
- Durden desktop environment are

- built on Arcan. The project’s codeis : development, the use of Lua is

written in C and distributed under a

- BSD license (some components are :
- licensed under the GPLv2+ and
- LGPL).

Put the fun back into computing. Use Linux, BSD.
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- can run on Xorg, egl-dri, libsdl, and
- AGP (GL/GLES). The Arcan display

server can run client applications
based on X11, Wayland and SDL.

. The project is developing its own

- fork of the X.org server, xarcan, as

- well as a composite arcan-wayland

- server (waybridge), which allows

- running Wayland-based

- applications. Key criteria used in the
© design of the Arcan APl include

- security, performance, and

. debuggability. To simplify interface

proposed.

https://arcan-fe.com/2025/12/27/

arcan-0-7-1-minutes-to-midnight/


https://distrowatch.com
https://www.reddit.com/r/linux/comments/1py5avz/orbitiny_desktop_pilot_8_release_the_biggest_and/
https://arcan-fe.com/2025/12/27/arcan-0-7-1-minutes-to-midnight/
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UBUNTU SwAY REMIX

25.10:;
30/12/2025

available, offering a pre-
configured, ready-to-use desktop
environment based on the Sway
tiled compositing manager. This

unofficial edition of Ubuntu 25.10 is

designed for both experienced
Linux users and beginners who
want to try out a tiled window
manager without the need for
extensive configuration. Builds for
the amd64 and arm64 (Raspberry
Pi) architectures are available for
download.

A feature of the distribution is
its complete abandonment of the
Snap package manager. All

programs are delivered as standard

deb packages, including the Firefox :
. personal liability in the event of

web browser, which is installed

using the official Mozilla Team PPA.

The distribution's installer is based
on the Calamares framework.

The new release features a
switch to Ubuntu 25.10, the
swaykbdd component for setting

individual keyboard layouts for each :
- donations. Projects supported by

window, minor optimizations to
system scripts, and the elimination

of a number of minor bugs.

: https://github.com/Ubuntu-Sway/
© Ubuntu-Sway-Remix/releases/tag/

buntu Sway Remix 25.10 is now 25.10 beta

. U-BOOT PROJECT:

30/12/2025

he U-boot project, that
develops a bootloader for

. embedded devices, has joined the
- Software Freedom Conservancy :
© (SFC), a non-profit organization that :
- collects and redistributes :
- sponsorship funds and provides

- legal protection for free software

- projects. SFC allows participants to
- focus on development while taking
© on the responsibility of collecting

- donations. SFC also takes

ownership of the project's assets
and indemnifies developers from

litigation.

Since the SFC falls under a

preferential tax category,

- channeling funds for U-Boot

- development through this

. organization will allow for tax

deductions when transferring
the SFCinclude BusyBox, CoreBoot,
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Git, Inkscape, Mercurial, OpenWrt,

QEMU, Samba, Sourceware, Wine,
- Xorg, and about a dozen other
: open source projects.

https://sfconservancy.org/news/

- LUSTRE 2.17 CLUSTER FILE

. SYSTEM:
. 31/12/2025

he Lustre 2.17 cluster file
system, used in most of the

- largest Linux clusters containing
- tens of thousands of nodes, has
- been released. Lustre's key

- components include metadata

- storage servers (MDS),

© storage servers (OSS), object

- storage (OST, which supports

- operation on top of ext4 and ZFS),
- and clients. The project's code is

- licensed under the GPLv?2 license.

https://www.mail-archive.com/
lustre-announce@lists.lustre.org/
msg00281.html

®s

SHoTCuT 25.12:
31/12/2025

hotcut 25.12, a video editor
developed by the author of the

: © MLT project and using this
+ 2025/dec/29/u-boot-has-joined-sfc/ : framework for video editing, has

: - been released. Support for video

- and audio formats is implemented

© via FFmpeg. Plugins implementing

- video and audio effects compatible
- with FreeiOr and LADSPA are

- supported. Shotcut features

* include multi-track editing, allowing
: video to be assembled from

- fragments in various source

. formats, eliminating the need for

© prior import or re-encoding. Built-in
© tools are available for creating

- screencasts, processing webcam

: . - images, and receiving streaming

: management servers (MGS), object © video. The code is written in C++

- using the Qt framework and is

- distributed under the GPLv3

- license. Pre-built builds are

© available for Linux ( Applmage and
© snap ), macOS, and Windows.

https://shotcut.org/blog/new-

release-25.12.30/
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https://sfconservancy.org/news/2025/dec/29/u-boot-has-joined-sfc/
https://www.mail-archive.com/lustre-announce@lists.lustre.org/msg00281.html
https://shotcut.org/blog/new-release-25.12.30/
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SDL 3.4.0 MULTIMEDIA

LIBRARY:
1/1/2026

DL 3.4.0 (Simple DirectMedia

Layer) is now available. This
library is designed to simplify the
development of games and
multimedia applications, offering
features such as hardware-
accelerated 2D and 3D graphics,
input processing, audio playback,
and 3D rendering via OpenGL,
OpenGL ES, Metal, Direct3D, and

licensed under the Zlib license.

in projects written in various
programming languages.

SDL 3.4.0 is the second major

stable branch in the SDL 3.x series — :

- on the Firefox 60.8 browser engine,
announced as 3.2.x, while 3.3.x was : With security fixes and some
© improvements backported from the

- latest Firefox branches).

the first stable branch was

positioned as experimental. The

main changes in SDL 3.4.0 include
improved portability between the
3D GPU API and the 2D rendering

into WebAssembly using the
Emscripten compiler, improved

support for graphics tablets and

the PNG image format.

https://discourse.libsdl.org/t/

announcing-sdl-3-4-0/65438

SEAMONKEY 2.53.23:

1/1/2026

eaMonkey 2.53.23, a suite of
web applications, has been

- released. It combines a web

- browser, email client, NNTP

: conferencing client, RSS/Atom

" news feed aggregation system, and
- Composer, a WYSIWYG HTML page

Vulkan. The code is written in Cand : editor, allin one product. Pre-
* installed add-ons include the

Bindings are provided for using SDL Chatzilla IRC client, DOM Inspector
. web developer toolkit, and

- Lightning calendar scheduling tool.
- The new release includes fixes and

- changes from the current Firefox

codebase (SeaMonkey 2.53 is based

Changes in the new version

API, expanded support fFor bu|[d|ng include : ChatZilla IRC client now

- uses the PluralForm library when

- formatting network parameters in
- plurals (e.g., 1 network, 5

digital pens, and native support for : networks). Service names in :
- dataman.js have been updated. CSS -

issues have been resolved.

https://www.seamonkey-

. project.org/news%232025-12-31

 ICEWM 4.0.0:

1/1/2026

ceWM 4.0.0, a lightweight
window manager, is now

- available. lceWM offers full control
- via keyboard shortcuts, virtual
deskops, a taskbar, and appllcat.|0n " "menu" button to open the system
- menus, as well as tabs for grouping :

- windows. The window manager is
- configurable via a simple

- configuration file, and themeing is
- supported. Tab-based window

© grouping is supported. Built-in

- applets for monitoring CPU,

- memory, and traffic are available.
- Several third-party GUIs for

- configuration, desktop

- implementations, and menu editors :
. are being developed separately.
" The code is written in C++ and

- distributed under the LGPLv2

- license.

The major version number

- change is a natural continuation of
- the project's version numbering

. (4.0 was created after the release
of 3.9). The new version features an

improved Alt+Tab interface for
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quickly switching between
windows, which can now handle

- multiple windows in both

- horizontal and vertical modes. After
- activating the Alt+Tab interface,

- new features are available, such as
- pressing the first letter of an

- application class name to switch to
- the next window in that class,

- pressing number keys or clicking

© the mouse to select an application,
© navigating between windows using
- the cursor keys, and pressing the

- menu.

The new version also includes

- alphaBlending enabled by default

© (alphaBlending=true) and 32-bit

- RGBA. A QuickSwitchPreview

- setting has been added, enabling

- application thumbnails in the

- window switching interface. The

- DoubleBuffer setting has been

- removed. Icon sizes have been

- standardized (16, 22, 24, 32, 48, 64,
© 128, 256). Icon rendering has been

- accelerated using caching. The text
- size in window templates is limited
- to 128 bytes. The

- getWorkspaceName and

. getWorkspaceNames options have
- been added to the icesh utility.

https://github.com/ice-wm/icewm/
releases/tag/4.0.0
h contents A
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DEvuAN 6.1:
2/1/2026

D evuan 6.1 "Excalibur" is now
available for download. It's a
fork of Debian GNU/Linux, shipped
without the systemd system
manager. Live builds with the Xfce
desktop environment (1.7 GB and
879 MB) and installation ISO
images (4.2 GB and 593 MB) are
available for download for the
amdé64 architecture. Packages are
built for the i386, amd64, armel,

architectures. Images for ARM
systems and virtual machines can

sdk and vm-sdk tools.

The project maintains forks of
approximately 400 Debian
packages, which have been
modified to remove dependencies

to the specifics of the Devuan
infrastructure. Two packages
(devuan-baseconf and jenkins-
debian-glue-buildenv-devuan) are
unique to Devuan and are related
to repositories and the build
system. Otherwise, Devuan is fully
compatible with Debian and can be
used as a basis for creating

specialized Debian builds without
systemd. Devuan-specific packages

. can be downloaded from the
- packages.devuan.org repository.

Changes in Devuan 6.1 primarily

- focus on synchronization with

- Debian 13.2, as well as support for
© the sysvinit, runit, and OpenRC init
- systems. Several issues in the slim

. login manager and the speech-

- synthesis package have been fixed.
- The community has created

- unofficial builds for Raspberry Pi

. boards. Additionally, testing of the
. - Devuan 7 "Freia" package

armhf, armé64, ppc64el, and riscv64 " repository has begun, based on the
- Debian Testing repository, which

. forms the basis for the upcoming

be created manually using the arm- Debian 14 release.

https://devigalaxy.org/
. viewtopic.php?id%3D7719

| SNoop 1.4.3:

on systemd, rebranded, or adapted :

2/1/2026

noop 1.4.3, a forensic OSINT
tool for searching public data

- for user accounts (open source

- intelligence), has been released.
- The program analyzes various

* websites, forums, and social

networks for the desired username,

allowing it to determine which
websites contain a user with the

. specified nickname. The project is
- based on research into public data
- scraping. Builds are available for

- Linux and Windows.

The code is written in Python

development since 2011, after
three years of conceptual and

. conceptual discussions. Pidgin 3

- Features the GObject type system,
- GTK4 and Adwaita libraries, the

: Meson build system, GPlugin for

- plugin processing, SQLite for

: - storing chat history, and GSettings
- and distributed under a license that :
- restricts use to personal use only.
- The project is a fork of the Sherlock :
- project codebase, which is licensed
- under the MIT license (the fork was
- created due to the inability to

- expand the site base).

for managing settings. The API has

- been completely redesigned. GTK

Builder XML is used to define

interface elements, and a custom
- widget library, Talkatu, has been
- created to display chat history.

: https://discourse.imfreedom.org/t/
© https://qithub.com/snooppr/snoop/ :

pidgin-3-0-experimental-5-2-94-0-

- releases

PIDGIN 3.0 MESSENGER
- RES:

2/1/2026

he fifth experimental release of :
0 © network, has been released. It

: supports Ogg Vorbis, Ogg Theora,
- Opus, FLAC, WebM (VP8/VP9), and
- proprietary codecs such as MP4

. (H.264, MPEG4), M4A, NSV, AAC,

- and MP3. The code is written in C

- and licensed under the GPLv2

the Pidgin 3.0 instant

© messaging client (2.94) has been

- released. This release is rated as

- being of pre-alpha quality, not

- intended for everyday use. Builds

© are available in Flatpak format and
- are hosted in the beta repository on :
- Flathub.

Pidgin 3 has been in
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- has-been-released/338

. IcECAST 2.5:

2/1/2026

cecast 2.5.0, a server for
streaming audio and video over a

- license.

The platform was created as an

h contents
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alternative to the proprietary
Shoutcast system and gained
widespread popularity in the early
2000s for creating internet radio
stations. In parallel, the projectis
developing the libshout library for
interacting with Icecast-based
servers and the IceS program for
sending audio streams to Icecast
servers. The development is
overseen by the Xiph.Org
Foundation.

https://icecast.org/news/icecast-
release-2 5 0/

MEeNUETOS 1.57.70:
3/1/2026

enuetOS 1.57.70, where the

kernel is developed entirely
ine assembly, is available.
MenuetOS builds are prepared for
64-bit x86 systems and can be run

and iso-image for recording on CD
(supported launch in VirtualBox).
The Menuet64 project code is
subject to a limited license
requiring the approval of any
commercial use, and Menuet32
under the GPL license.

The system supports
displacement multitasking, loading

- on systems with UEFI and SMP on

- multi-core systems. The project also
- develops its own X-server and

- provides a built-in graphical user

* interface with the support of

: design topics, Drag & Drop

- operations, UTF-8 encoding and

- keyboard layout switchings. For the
- development of applications in the
- assembly language, an own

- integrated development

. environment is offered.

The operating system has a

- network stack, drivers for Ethernet
- and USB 2.0, AC97 audio codecs

- and Intel HDA (ALC661/2888). The
. project develops a simple web

- browser HTTPC, mail and ftp

- clients, VNC client, ftp and http

. servers, applications for viewing

- images, editing texts, working with
- files, watching videos, playing

- music. To navigate the Ffiles, it is

under QEMU. Building system takes

up 1.4 MB and is in a diskette image : proposed to use the file manager

: NDN (Necromcer's Dos Navigator),
- ported for MenuetOS.

You can launch a DOS emulator

and play games like Quake and
- Doom. Compatibility with Linux is
- provided using the basic layer of

POSIX, which allows you to create
GUI applications that can be runin

Menuet and Linux / X11, as well as
its own X-server, written in

- assembly, in which you can redirect
- the output of the application

- running on the external system

- with Linux, to display its interface in :
* MenuetOS.

https://www.reddit.com/r/linux/
comments/1g20c06/ :
" menuetos running some simple i

- nux_x11/

. Box64 0.4.0:

4/1/2026

ox64 0.4.0, designed to run
Linux programs built for

- x86_64 architecture, on equipment
- with ARM64, RISC-V and

- Loongarch64 processors, is ready.

- The project pays great attention to
- launching games and provides the

- opportunity to run Windows builds
. through Wine and Proton. The

- original code of the project is

- written in C and distributed under

- the MIT license.

A feature of the project is the

use of a hybrid execution model,
- where emulation is applied only to
- the machine code of the application

itself and specific libraries. Typical

full circle magazine #225 @ 8

system libraries, including libc, libm,
GTK, SDL, Vulkan and OpenGL, are

- replaced by options native to target
- platforms. Thus, library calls are
- performed without emulation, this

allows for a significant increase in

- productivity.

https://box86.0rg/2026/01/new-
- box64-v0-4-0-released/

MANJARO LINUX 26.0:

5/1/2026

anjaro Linux 26.0, a n00b-
focused distribution based on

- Arch Linux, has been released. The
- distribution features a simplified

- and user-friendly installation

. process, automatic hardware

- detection and support for installing
- necessary drivers. Manjaro is

- available as live builds with KDE (5.4
: GB), GNOME (5.2 GB) and Xfce (5.1

: GB) desktop environments,

- designed for the x86_64

- architecture and various ARM-

- based boards. Budgie, Cinnamon,

- Deepin, LXQt, and i3 builds are also
- being developed with community

- input.

Manjaro uses its own BoxIt
repository management tool,

h contents A
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modeled after Git. The repository is
maintained using a rolling update
system, but new versions undergo
an additional stabilization phase. In
addition to its own repository, it
supports the AUR (Arch User
Repository). The distribution
includes a graphical installer and a
graphicalinterface for system
configuration.

https://forum.manjaro.org/t/
manjaro-26-0-anh-linh-released/
184526

PCSX2 2.6.0:
5/1/2026

he PCSX2 2.6.0 project, a
PlayStation 2 emulator, has
been released. The emulator allows

standard PC and utilize advanced
features such as screen resolution
adjustment with output scaling,

cards, saving game state, patching
games, and recording gameplay
video. MIPS CPU emulation on x86
systems is achieved using

a virtual machine. The emulator's
performance and capabilities are
sufficient to run 99% of the 2,500

games tested for the Sony
PlayStation 2, including Final

- Fantasy X and Devil May Cry 3. The
- project's code is written in C++ and
* is distributed under the GPLv3

- license.

https://pcsx2.net/blog/2025/pcsx2-
26/ '

- GNU WGET2 2.2.1:

5/1/2026

NU Wget2 2.2.1 is now
available. It represents a

. completely rewritten and

© redesigned version of the GNU

© Wget program for automated

: recursive content downloading.

. Wget?2 offers a range of additional
- options, supports multi-threaded
you to run PlayStation 2 gameson a :
- available functionality through the
. libwget library, supports HTTP/2
*and TLS 1.3 protocols, enables the
creating virtual and shared memory :
© can save data from streaming

. servers, correctly handles

- internationalized domain names,
- and can transcode downloaded
recompilation and interpretation in :
. the GPLv3+ license, and the library
" is licensed under the LGPLv3+

downloads, enables the use of

download of only changed data,

content. Wget?2 is licensed under

license.

https://www.mail-archive.com/info-

. gnu@gnu.org/msg03481.html

. MIDESKTOP:

5/1/2026

The project's stated goal is to

- modernize the KDE 1 codebase
- without overloading the

© environment with unnecessary
- functionality. MiDesktop intends to :
- maintain the overall minimalist

. approach to desktop development
- from the late 1990s and early

~ 2000s, while eliminating the

shortcomings inherent to those
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systems. MiDesktop's key features
include a simple interface,

- lightweight design, and high
- performance.

MiDesktop requires any Linux

- system with glibc and an X server,
- such as XWayland or X.Org Server,
he first experimental release of or the Wayl?aclf layer. -
: the MiDesktop project, a fork of : Dependencies include libjpeg,
- the KDE 1.1.2 desktop

© environment, adapted for modern
- systems, has been released. The

- KDE 1 codebase has been ported to :
- the Qt 2 framework to address :
- issues and licensing limitations
- specific to the Qt 1 branch. The
- Osiris project, led by the same

- developers, is developing an

- updated fork of Qt 2.3.2. :
- MiDesktop's code is licensed under :
- the GPLv2 license. Builds are

- available for Debian 13 and Ubuntu
© 24.04.

- libtiff, libpng, Osiris Toolkit 2.4.4+,
- libxcb, libxkb, and gettext. CMake
- and GCC 12+ are required for

- building.

- https://www.reddit.com/r/linux/

© comments/1a17svp/

- midesktop kde1 fork developmen
. L preview release/

. DEBIAN DATA PROTECTION
. TEAM HAVE RESIGNED:

5/1/2026

ndreas Tille, the Debian project
leader, published a report

- highlighting problems within the
. Data Protection Team: three

- members of the team resigned

- simultaneously. The reason cited
- for their departure was a lack of
- capacity and enthusiasm to

continue working. The team is now
without members, and the project
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is urgently seeking volunteers to
replace them.

The Data Protection Team was
established in 2018 to coordinate
compliance with European data
protection law (GDPR), respond to
requests for project-stored data,
advise Debian developers on
personal data processing, and

improve privacy policies. Applicants :
- adopted, Firefox users will have to
- manually change the

- "middlemouse.paste" setting in the :
© about:config page.

must have a working knowledge of
data protection and an
understanding of GDPR
requirements.

https://lists.debian.org/debian-
devel-announce/2026/01/
msg00004.html

MIDDLE-CLICK PASTE:
5/1/2026

disable by default a useful feature
of Linux graphical environments—
the ability to quickly paste

clipboard contents by pressing the

are currently under review and have:

not yet been finalized.

Firefox developers cite the

feature's unfamiliarity with new
users, who are confused by

. accidental mouse wheel clicks, as

. the reason for disabling it. They

- also cite a wiki page on

- freedesktop.org, which claims that
- normal clipboard behavior in Linux
- matches that of Windows and

- macOS, and presents middle-click

- pasting as an "Easter egg" for

experienced users. If the change is

- Thereason for disabling middle- :
- click paste in GNOME is to remove
- specific X11 features (Wayland also :
- supports this feature ), which cause
- unexpected behavior for users of

- other platforms and are typically

- used accidentally. It is expected

- that users who value middle-click

hanges have been proposed for paste will be able to enable it by

use in GNOME and Firefox that : . _
: command "gsettings set

. org.gnome.desktop.interface gtk-
- enable-primary-paste true."

changing the settings with the

middle mouse button. The changes https://www.phoronix.com/news/

: GNOME-Firefox-MiddleClick-Paste

®
Privoxy 4.1.0:
6/1/2026

: release of the Privoxy 4.1.0
: proxy server, designed to create

- cookies, delete pop-up dialogues,

- JavaScript code and make the

: user's arbitrary changes to the web

© pages. Privoxy supports the

- individual users and servers to

© create a centralized storage

- infrastructure for filtering content
. on the local network. The project

- code is written in C and distributed
- under the GPLv2+ license. Ready-

- made builds are prepared for Linux
- (deb) and Windows.

- ability to link tags to change the

- behavior of filters depending on

- individual client and server HTTP

- headers; HTTPS inspection mode,

- allowing you to filter HTTPS queries

- and responses; using regular

- expressions in configuration files;

- the ability to replace animated gifs

- with striped static images. Privoxy
can be used to block ads and
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unwanted content on devices
where it is impossible to install the

. appropriate browser add-ons.

fter a year of development, the :
- https://www.privoxy.org/gitweb/?

: p=privoxy.git;a=blob:f=doc/

. webserver/

- personal filters of web content, was :

- published. With Privoxy, you can cut © announce.txt:h=78e2a9082a2d030

* advertising inserts, discard tracking : 4e47243acc25b6816ccf58a9b;hb=4

- 81b2322909dd35158882064f2267

- block the download of a third-party f696461e333

. Loss32:

- installation of both local systems of :

7/1/2026

he Loss32 project is developing
a Win32/Linux distribution that

- combines the Linux kernel with a

- Windows-style graphical

- environment built on Wine and

- custom ReactOS components. The

. distribution aims to recreate the

- Windows desktop environment and
Aadvanced features include: the : provide tools for seamlessly

: running Windows applications,

- while also supporting traditional
- Linux programs. The first Loss32
- prototype is scheduled to be

- published this month.

The project's goals are very

- similar to ReactOS and also attempt
* to recreate a Windows-style

operating system, but it differs in
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its refusal to use the Windows NT
kernel. According to the creators of
Loss32, the main factor hindering
ReactOS developmentis the
attempt to create a custom

Windows NT kernel, which prevents

it from achieving adequate
hardware support, stability, and

focus its efforts on creating a
Windows application runtime
environment, using a system
environment based on the well-
functioning Debian 13 and Wine.

Unlike traditional Linux

space components with Wine
where possible and the desktop
environment is based on Win32
applications and libraries, such as
explorer.exe and shell32.dll from
Wine and the ReactOS project.
Mutter serves as the compositing

from the late 1990s to the early
2010s. The system allows loading
and running executable files

like in Windows.

https://news.ycombinator.com/
item?id%3D46424173

LINUX KERNEL BUG FIX

~ ANALYSIS:

8/1/2026

30% of bugs were fixed by the

- same developers who introduced
- them. 56.9% of bugs are fixed

- within a year. 13.5% of bugs

- remained undetected for more

. than 5 years (if we consider only

manager. The design is styled after . bugs fixed in 2025, this figure is

. [o)
the classic Windows interface used 19.4%). Due to the uneven

- distribution, the median lifetime of :

- a kernel bug was 8 months for the QEMU & 32-BIT HOSTS:
- sample since 2005 and 1 year for :
containing Windows programs, just bugs fixed in 2025. The longest- :

' - lasting bug was a buffer overflow in :

ethtool, fixed after 20.7 years.

The statistics also reflect the

* impact of the introduction of new

tools for automated error

detection, static analysis, and code
testing, such as Syzkaller, KASAN,

- KMSAN, and KCSAN. For example,
- in 2010, no bugs found were fixed
he results of a study on the time \;V;E/hmfabyear. Mear;whﬂj, 'r.]tipm’
it takes to detect and fix bugsin : o OTDUgs were "ounc wittin @
© Linux kernel code have been

) . . : published. The data was obtained
Functionality. Loss32 has decided to by analyzing the fixes of 125,000
- bugs tagged in the Git repository
- with the "Fixes:" tag, which refers
© to the commit in which the bug was :
- introduced. The average time to

- detect kernel bugs was 2.1 years. If
- we consider only bugs fixed in

distributions, Loss32 replaces user- 2025, this figure was 2.8 years.

- year, in 2018, the figure was 54%,
- and in 2022, the figure was 69%.

The resulting statistics were

© used to create the VulnBERT

- machine learning model, which

- predicts the presence of

- vulnerabilities in commits. When

" tested on commits from 2024, the
- error detection accuracy was 92.2%
- with a false positive rate of 1.2%
- (by comparison, the previously

* available CodeBERT model

- detected 89.2% of issues with a
- false positive rate of 48.1%).

o et e o orat
. kernel-bugs

10/1/2026

ichard Henderson, one of the
QEMU project maintainers and

the second-largest contributor, has
: published a set of patches
- removing support for 32-bit host

systems from QEMU. Support for
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32-bit host environments was
deprecated in April of last yearin

- QEMU 10.0, and support for mips32
- and ppc32 platforms was removed

- from the Tiny Code Generator ( TCG
- ) in December 10.2.

Barring any unforeseen issues,

- the QEMU 11.0 release, scheduled

- for mid-spring, will remove support
- for the remaining i386, arm, ppc,

- and riscv32 platforms from the

- TCG, as well as clean up the

- codebase and build system of

© components for running on 32-bit

hosts.

https://lists.nongnu.org/archive/
: html/gemu-devel/2026-01/
: msg00902.html

DEeBIAN 13.3 AND 12.13:

10/1/2026

he third corrective update for
the Debian 13 distribution has

* been released, incorporating

- accumulated package updates and
- fixes to the installer. This release

- includes 108 updates that address
- stability issues and 37 updates that
- address vulnerabilities. Changes in
- Debian 13.3 include updates to the

latest stable versions of the ansible,
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apache?, containerd, dpdk, flatpak,
gnome-shell, mbedtls, mutter,

postgresql-17, and gemu packages.

Debian 12.13 is available,
containing 96 updates fixing
stability issues and 85 updates

latest stable versions: apache?,
clamav, dpdk, intel-microcode,
nvidia-graphics-drivers, openss|,
postgresql-15, gemu, and ublock-
origin. For the armel, mipsel, and

libclamunrar, and pg-snakeoil
packages have been removed due
to the unavailability of the rustc-
web package for these

building new versions of packages
with ClamAV. The pagure package,
which contains unfixed issues and
vulnerabilities, has also been
removed.

https://www.debian.org/News/
2026/20260110

BuDGIE 10.10 PORTED TO

WAYLAND:
10/1/2026

he Budgie 10.10 desktop

Due to the transition to

- Wayland, many auxiliary

- components have been replaced:
- The grim and slurp utilities are used :
- for creating screenshots and

- selecting screen areas. Screen

- locking, activating the screensaver
- during inactivity and power

- management are implemented

- using swayidle, gtklock (or

swaylock), and wlopm. The swaybg

utility is used for managing the
desktop wallpaper. The xdg-

- desktop-portal-gtk and xdg-
- desktop-portal-wlr XDG portals are
- used for screen sharing and

. - recording screencasts from
environment has been released, :

fixing vulnerabilities. The following : completely removing X11 support

packages have been updated to the Wayland-based environments.

- Similar releases have also been

- seenin related components,

- including the Budgie Session

. session manager, the Budgie

mips64el architectures, the clamavy, Desktop View desktop, the Budgie

clamsmtp, libc-icap-mod-virus-scan, Control Center system
' ' ¢ configuration interface and the

© Budgie Desktop Services suite. The

. project's code is licensed under the

. GPLv2 license. Budgie 10.10

. o . . packages are already available in

architectures, which is required for . Fedora Rawhide and will be

- included in Fedora 44 and Ubuntu

Budgie 26.04.

: applications. wdisplays is
: recommended for setting up multi-

and leaving only the ability to runin monitor configurations.

https://buddiesofbudgie.org/blog/
budgie-10-10-released

AuTO-CcPUFREQ 3.0.0 AND
TLP 1.9.1:

12/01/2026

uto-cpufreq 3.0.0, a utility
designed to automatically

- optimize CPU speed and power

© consumption, has been released.

* The utility monitors laptop battery
status, CPU loa.d,.CPU temperaFure, . modes, the utility supports
- and system activity and dynamically
© activates power-saving or high-

- performance modes based on the
- situation and selected options. It

- supports devices with Intel, AMD,

- and ARM processors. It can be

- controlled using a GTK-based

- graphicalinterface or a command-
- line utility. The code is written in

Python and distributed under the
LGPLv3 license.
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The new version implements the

- ability to forcefully enable or

- disable CPU turbo boost via the GUI
- and command line ("auto-cpufreq--
- turbo={never|always|auto}"),

- regardless of the battery charge

- level. A battery_device parameter

- for selecting the battery has also

- been added to the configuration

- file, in case the default battery is

- not automatically detected

- correctly (available batteries can be
- found in the /sys/class/

. power_supply/ directory). A sample
- configuration file for Nixos has

- been added.

Also noteworthy is the release

- of TLP 1.9.1, a utility designed to
: automatically optimize power

- consumption and extend laptop
- battery life. In addition to

- 'managing CPU power-saving

. adaptive enabling and disabling of
. Bluetooth, NFC, and Wi-Fi. The

. project code is written in Shell and

- Python and is distributed under the
- GPLv2 license.

The 1.9 branch is notable for the

addition of an optional background
© process, tlp-pd, which enables

switching between three power
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profiles: performance, balanced,
and power-saver. This background
process can be used as a

GNOME, KDE, and Cinnamon. The
tlpctl utility is also included for
switching profiles from the
command line and launching
individual applications with a
specified profile. The 1.9.1 patch
release fixes a vulnerability (CVE-
2025-67859) in the new tlp-pd
background process.

https://www.reddit.com/r/linux/
comments/1ga715a/
autocpufreg v300 is out/

BUDGIE DESKTOP CHANGES:
12/01/2026

he Buddies of Budgie

developers have published a
report on the development of the
Budgie desktop environment,
outlining achievements through
2025 and outlining plans for 2026.
Following the release of Budgie
10.10, which migrated to Wayland,
all attention has shifted to the
development of the Budgie 11
branch.

Budgie 11 will use Qt6 and

. supporting libraries from the KDE
replacement for the power-profiles-

daemon service and supports the D-:
Bus API used for profile switching in :

Frameworks suite instead of GTK
for display management. The
migration has already been tested

© in the Budgie Display Configurator
- application, it is developed using

- Qt6 and the Kirigami interface

- framework (a Qt Quick Controls

- add-on).

The Budgie Core layer contains

© the base libraries used by all
- devices, is responsible for launching :
. components depending on the

- device type, and provides libraries

© for organizing information output,
- supporting languages and locales,

© managing power consumption,

- interacting with input devices, and
- configuration.

The Budgie Desktop layer is
implemented on top of Budgie

- Core and provides graphical shell

- functionality. This layer handles

- operations such as window layout,
- desktop and application

- management, and user interface

- design. Budgie 11 also features

- cross-platform theme support and
- the ability to replace components
- and extensions, such as the

: compositing server, notification

: Budgie 11 will feature a modular
- architecture, divided into two :
- layers: "Budgie Core" and "Budgie
- Desktop." This modular

- architecture will allow the project
© to adapt to new form factors, input
- devices, and workFflows. For
- example, Budgie will be compatible :
- notonly with PCs and laptops, but
- also with tablets, TVs, VR devices,
- and smartphones.

display system, and panels.

https://buddiesofbudgie.org/blog/
. state-of-the-budgie-2025

. ARCHBANG RELEASE 1001:;

13/01/2026

rchBang 1001, a lightweight
Linux distribution based on

- Arch Linux and featuring a user

- interface based on the Labwc

© compositing manager, is out. The
- distribution offers a continuous

- update cycle, ensuring you always
- have the latest versions of software :
- from the Arch Linux repositories.
- The ISO image size is 1.4 GB.

The new version features a

* switch to the Labwc composite

manager, which uses the Wayland
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protocol and is similar in
functionality to the Openbox

- window manager originally used in
- ArchBang. The dmenu application
- menu has been replaced with

- wmenu, which supports Wayland.

- XWayland is now included for

- launching X11 applications. Other
- changes include switching the

- installer to full-screen mode,

- adding an applet for configuring a
* network connection using

- NetworkManager, and a redesigned
- theme.

https://archbang.org/2026/01/10/
© a-new-release-image-and-another-
- app-launcher/

OMARCHY 3.3:

13/01/2026

D avid Heinemeier Hansson,

author of the Ruby on Rails

web framework, has published the
: Omarchy 3.3 distribution, which
. reflects his vision of the ideal Linux

environment. The distribution is

© being developed in accordance with
- the "Omakase Computing"

- principle, which assumes that most
- users, when starting out, don't

" know exactly what they want and

are better off not torturing
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themselves with choice, but using a
set of tools prepared by someone
whose expertise and taste they
trust. The project's work is
distributed under the MIT license.
The ISO image size is 7.2 GB.

environment is part of that
motivation. Omarchy offers only
the applications David uses every
day—from Neovim, Chromium and
LibreOffice to Spotify, Typora,
Ghostty and Zoom. Omarchy
doesn't try to be like Windows or
macOS, cater to the masses, or
appeal to casual users. The
environment, including coding in
Neovim, extensive use of the
terminal, and tiling windows will
feel unusual to many, but those
who dare to step out of their
comfort zone and learn something
new will be able to improve their
productivity.

https://github.com/basecamp/
omarchy/releases/tag/v3.3.0

ANTHROPIC DONATES $1.5

. MILLION TO PYTHON:

14/01/2026

nthropic, the developer of the

: Claude family of large language :
David believes that motivation is : models, has awarded the Python

essential for high productivity and a - Software Foundation (PSF) a $1.5

beautiful and aesthetically pleasing : mllllon grant. The funds will be

- disbursed gradually over two years
- and will support work to improve

- CPython and strengthen

- protections against supply-chain

- attacks on the PyPI (Python

. Package Index) repository.

tools will be usable not only on PyPI
but also on other open repositories.

https://pyfound.blogspot.com/

: 2025/12/anthropic-invests-in-
: python.html

. LINUX MINT 22.3:

14/01/2026

L inux Mint 22.3 has been

released, continuing the

- development of the Ubuntu 24.04
- LTS- based Linux distribution. While :
. fully compatible with Ubuntu, the
- distribution differs significantly in
* its approach to user interface

: The allocated funds are planned
© to be used to develop new tools for : application selection. Linux Mint
- automated review of packages
- uploaded to the PyPI (Python

- Package Index) directory. Instead of :
© the current "reactive" approach,

- which involves reviewing packages
- after they are already available in

- the directory, they intend to

- implement a "proactive" approach,
. whereby review is performed

- before the package is made

- available to users. To identify

- malicious packages, they intend to
- use functionality analysis that takes :
- into account the typical elements

. of known malware. The developed

organization and default

- developers provide a desktop
- environment that adheres to classic
- desktop layout principles and is

- more familiar to users who are not
- comfortable with the new GNOME
* 3interface design. DVD builds

. based on the MATE (3.1 GB),

- Cinnamon (3 GB), and Xfce (3 GB)

- desktop environments are available :
- for download. Linux Mint 22 is a :
- long-term support (LTS) release,

- with updates expected until 2029.

- https://blog.linuxmint.com/?
: P%3D4981
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GNU GRUB 2.14:
15/01/2026

fter two years of development,
the stable release of the

- modular, multi-platform GNU GRUB
- (GRand Unified Bootloader) is now
© available. GRUB supports a wide

- range of platforms, including

- standard BIOS-based PCs, IEEE-

© 1275 platforms (PowerPC/Sparc64-
- based hardware), EFI systems,

- systems with RISC-V, Loongson,

- Itanium, ARM, ARM64, LoongArch,
- and ARCS (SGlI) processors, and

- devices using the open-source

. CoreBoot package. The project's

. code is written in C and distributed
- under the GPLv3 license.

. https://www.mail-archive.com/
. grub-devel@gnu.org/
msg42902.html

DEBIAN LiBRE 13.3:

15/01/2026

D ebian Libre 13.3 has been

released, representing Debian

- 13.3 boot images stripped of non-
- free components such as firmware
- blobs. The project is being

~ developed by Simon Josefsson,

who maintains 170 Debian
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packages.

In accordance with a decision
made in 2022, official Debian ISO
images include both free firmware
from the main repository and
proprietary firmware distributed
through the non-free-firmware
repository. Debian Libre creates
official live image editions for the
x86_64 and ARM64 architectures,

13 without using non-free
components.

Live builds with GNOME, KDE,
and Xfce come with the Calamares

installer. A "standard" build without
: server applications, developer

- tools, and isolated containers,
. among other things.

the graphical environment (1.9GB)
and a stripped-down "slim" build
(750MB) are also available. ARM64
builds support the following PCs:
ADLINK Ampere Altra and MSI
Z790-P WIFI PRO i9-149500K
Dasharo; Framework 13 AMD Al 9
HX 370, Lenovo X201 i7-620M,
NovaCustom NV56 Intel Ultra 7
155H i915 Dasharo; and Dell
PowerEdge R630 2xE2680v4,
Protectli VP2440, and Supermicro
MegaDC ARS-110M-NR Ampere
Altra Max servers.

https://blog.josefsson.org/
2026/01/13/debian-libre-live-13-3-
0-is-released/

. DEBIAN ON AN OPENWRT
. ONE:

16/01/2026

C ollabora has developed the

openwrt-one-debian toolkit for

- installing and running Debian GNU/
- Linux on the OpenWrt One open
allowing you to run or install Debian source router. This toolkit allows

- you to transform OpenWrt One

- from a specialized network device
- with a stripped-down Linux

- environment into a full-fledged

© general-purpose Linux system,

capable of running any services,

The toolkit's Functionality

- consists of flashing the u-boot

- bootloader and a recovery

- environment to the integrated 256-
: MB NAND Flash memory for

- installing and booting a Debian

- system image onto an NVMe drive
- connected via the M.2 slot. The

- NOR Flash memory is

- unchangeable, so you can always

- revert to the stock OpenWrt

. environment if desired. The

installed system environment
includes minimal tools forinstalling

packages from Debian repositories,
an OpenSSH-based SSH server,

. Hostapd with presets for wireless

- interfaces, systemd-networkd with
© settings for obtaining IP addresses
- for WAN and LAN interfaces via

: DHCP, and udev rules for LED

- indicators.

The OpenWrt One router,

- developed jointly by the OpenWrt
- and Banana Pi projects, is equipped
- with a MediaTek MT7981B (Filogic
- 820) SoC with a dual-core Cortex-
- A53 1.3 GHz CPU, a MediaTek :
: MT7976C wireless chip (Wi-Fi 6, 2x2
© 2.4 GHz + 3x3/2x2 + DFS 5 Ghz), 1
GB of RAM (DDR4), 256 MB of SPI

- NAND Flash and 16 MB of SPI NOR
: Flash. The device comes with two

- Ethernet ports (2.5 GbE + 1 GbE),
- USB 2.0 host Type-A, an M.2 slot for :
- NVMe SSDs, USB-C (Holtek

. HT42B534-2 UART with USB

- converter, console, and CDC-ACM
. support), 10-pin JTAG, and a

- mikroBUS expansion slot.

© Schematics and PCB layouts are

- provided.

https://www.collabora.com/news-
and-blog/news-and-events/
: openwrt-one-meets-debian.html
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GNOME 50 ALPHA

. RELEASE REMOVES X11
. SUPPORT:

16/01/2026

he first alpha release of the
GNOME 50 desktop

- environment has been released.

© The release is scheduled for March
- 18,2026. A 3GB ISO image based

- on the GNOME OS distribution has
- been created for testing the alpha
- version of GNOME 50.

A key change in the GNOME 50

- alpha release was the removal of

© X11 support from the GNOME Shell
- user interface and the Mutter

: compositing server. The GDM

- display manager has removed X11

support and the ability to build

- GDM without Wayland has been

- discontinued. Support for running
- other desktop environments using
- X11 remains, though.

https://discourse.gnome.org/t/
- gnome-50-alpha-released/33616
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KDE PLASMA 6.6 BETA:
17/01/2026

he latest KDE weekly

development report has been
published, presenting the first
batch of changes for the KDE
Plasma 6.7 branch, expected to be
released in June. Development of
the new branch began after the
KDE Plasma 6.6 branch entered
beta testing and the associated
codebase was frozen from making
functional changes (only patches
are accepted). The release of KDE
Plasma 6.6 is scheduled for
February 17. The have a whole list
of changes at the following URL.

https://blogs.kde.org/2026/01/17/
this-week-in-plasma-dark-mode-
switch-and-global-push-to-talk/

NvTOP 3.3.0:
18/01/2026

N vtop 3.3.0, a command-line
utility For interactively
monitoring GPUs and hardware
accelerators, has been released.
The utility allows you to visually
monitor GPU load, memory
consumption, and frequency
changes, as well as view the

processes that are most heavily
loading the GPU. Supported GPUs

- and accelerators include AMD,

- Apple (M1, M2), Google (TPU),

© Huawei (Ascend), Intel (i915/Xe),

- NVIDIA, Qualcomm (Adreno),

- Broadcom (VideoCore), Rockchip,
- MetaX, and Enflame. Monitoring

- multiple GPUs simultaneously on a
- single screen is also possible.

The new version adds support

- for the Enflame GCU (General
- Computing Unit) and Rockchip NPU :
. Al accelerators, as well as MetaX

- GPUs. Support for Mali, AMD, and

- NVIDIA GPUs has been improved.

© Memory information in the

- summary report has been

- expanded. A CTRL + L shortcut has
© been added to reset the interface.
- Amore visual load metric has been
- added, calculated as a percentage
- of the current load relative to the

* maximum load. A power

: consumption graph for the Intel

. Battelmage has been added.

https://github.com/Syllo/nvtop/
- releases/tag/3.3.0

o
CHAOSBSD:
18/01/2026

he ChaosBSD project maintains

: a periodically synchronized fork
- of FreeBSD, aimed at testing drivers :

: before their inclusion in the main

- FreeBSD distribution. The project

- provides a platform for developing
- and porting new drivers, as well as
© testing and stabilizing partially

: functional, unstable and unfinished

- drivers, whose development status

in the main FreeBSD distribution.
: Once stabilized, these drivers will
- be ported to FreeBSD.

: There are four stages of driver

- development: achieving build-

- ability; bug fixing and stabilization;
- cleanup and documentation; and

- transfer to the FreeBSD core team.
- ChaosBSD is considered a testing

- platform and does not guarantee

. the preservation of change history
- and commits. The repository is

- periodically reset, synchronized

- with the FreeBSD codebase, and

- the state is then restored.

https://www.osnews.com/story/
© 144210/chaosbsd-a-freebsd-fork-

- to-serve-as-a-driver-testing-ground/ :
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. prevents them from being included
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‘ Written by Erik

Symlinks, or the proper name,

symbolic links, are a
fundamental Feature in any Linux
distro. Symbolic links allow you to
establish shortcuts to files and
folders, even across different
locations.

Symbolic links act as pointers to
files or directories and don’t store
the actual data. They are not hard
links, which directly reference file
data at the inode level; symlinks
reference only the file path. If the
original file is moved or deleted,
the symlink becomes broken.

Another way to look at them:
« Soft link or symbolic link: This is
merely a shortcut to the original
file.
 Hard link: This points to the

memory location of the original file. is easier to see (see image below).

The command we will be using is

In. If you look at the [n man page, as : oyt is that the permissions line

- starts with an “l”, you should know :
edd
edd
edd

a newbie, it will tell you almost

nothing. In cases like these, | like to

refer to geeksforgeeks, if | can
(https://www.geeksforgeeks.org/
linux-unix/ln-command-in-linux-
with-examples/), as there are

usually real-world examples.

How it works, syntax:

- ln <option> source alias

- 1n source alias

: To create a symbolic link to a file, : : :
- use the option -s with the target file : say, we are 4 links deep and link 2

. name and the link name:

. In -s source alias

Symlinks are displayed in a

- different colour in Ubuntu. (this is
- not true for all terminal emulators).

When one does a long listing, it

The other thing I'd like to point

edd
edd
edd

drwxr-xr-x 15

Lrwxrwxrwx 1

drwX-====- 3
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the “d” in the image is for directory.
- However a link to a directory is still
- alink and will start with an “l".

We can also symlink a symlink, |

_ _ - actually want you to do that now;
To create a hard link to a file, you

© can use the In command without
- any options like this:

- make a symlink, then make a

- symlink to that symlink, and do a

- long listing and notice the colors in
- your terminal. Some may even say
- you are chain linking. Chain linking  :
- is generally considered bad, as, let's

: 1n -si snap choons

- breaks... See where this is going?

This is all fine and well, so far,

but what if | delete the source file
- or break my symbolic link in some
. other way? Deleting a symlink does

not affect the original file, as it is a

: pointer to that file, but let’s say |
- deleted my oops.png file, what do
- you think would happen?

How can we fix it? We cannot
- just “re-direct” it? Or can we?

é lrwxrwxrwx
- 11 Sep 21 14:40
. deblist.txt

Symlinks

We simply force it, with -f, like

. so:

é 1n -sf deblist.txt mysymlink

Then, as you can see:

1l edd edd
mysymlink ->

Nice! Your other option is, -i

Now choons links to my snaps

Folder instead of my music folder.

© lrwxrwxrwx 1 edd edd
: 4 Sep 21 14:45 choons —>
: snap

Any questions? | hope you

: opened your terminal and tried it if
© you are a newbie to Ubuntu.

Let's move along. There is also

- an unlink command, but honestly, |
- have never seen the need. In all my

ears of using Linux, | have never



https://www.geeksforgeeks.org/linux-unix/ln-command-in-linux-with-examples/
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needed it. If I want a link gone, |
delete it, as rm is much quicker to
type :) Deleting the symlink does
not affect the source file (Target).

While the link itself is of no
consequence, when | open the link
and edit its contents, the original

file changes. Though this seems like :
common sense, remember common :
- permissions from the symlink and
© see what happens. If you tried the
- above, and are confused, let us
look at the permissions? Other than :
- without trying, let us know at

- misc@Fullcirclemagazine.org. Those
- of you with hard beards reading :
- this with a glintin your eye, let the

- newbies cook and remember this

- on April fool’s day, next year. This is

- also a good interview task/

- question.

sense is not always common.
Remember that | told you to

the “l”, what did you notice? Go
ahead and look again if unsure, I'll
wait...

The eagle-eyed among you may
have noticed that the permissions
the symlink always gets created
with is 777 (rwxrwxrwx). Usually
777 is a bad thing. However, that
does not affect the permissions of
the target file or folder, they
remain the same. When you click
the link, it simply links you to the
source file (target), and its
permissions, meaning that if you
had only read permissions on the
file, even if on the symlink, you
have write and execute
permissions, you will still only have
read permissions on the source file
(target). You can test it out by
trying to change the permissions of

the symlink and it will not affect
your permissions on the source. Go

- ahead and try it now. You still
© remember how chmod works,
- right? Just remember that :
. permissions are not passed on (your :
. takeaway). :

As a bonus, | want you to try to
remove read, write and execute

know, or if you think you know

Ok, we have covered linking and

unlinking and fixing broken links.
- This will cover you for most things
: (80/20 principle).
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=
Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine sized
hard drives with multimeters and

oscilloscopes, laying cable, to scaling
3G towers, he's done it.
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Written by Erik

W ith the news of more
countries and monkey-palities :

© one | use most and | suspect
© everyone else uses the most,
- Writer.

dropping MS Office (eg. https://
www.heise.de/en/news/From-
Word-and-Excel-to-LibreOffice-
Danish-ministry-says-goodbye-to-
Microsoft-10438942.html) |
thought it may be a good
opportunity to do some thingsin
LibreOffice.

| was chatting with one of my
friends who still uses Windows;

what do they do in Office? | found a :
very interesting trend in perception :

between male and female friends
regarding MS Office and other

discuss that in a later issue. Of my
smarter friends and acquaintances,
I got replies of; you cannot do x or

y, but when | asked if they had ever

“"_.n “"_n

done the “x" or the “y”, or even
knew anyone who did x ory, the
response was negative. To me, this

means that they were influenced by

something that they read, rather
than really “knowing”.

Looking at my list of things
people say they do, I'll create this
series of articles around that. We

can start with the basics and work
our way up. We will start with the

We can start with something

- visual. Making your paragraphs look :
- snazzy. When you see old :
- manuscripts, they have that large
- capital letter that starts off the

- text: (https://

. abcdefridays.blogspot.com/

2014/09/drop-caps.html)

In LibreOffice, it is called drop

caps, and you can find it in: Format
office packages, and maybe we can

Settings

Display drop caps

Contents

: > Paragraph, and it should be the

- sixth tab, with a check-box “Display
- drop caps” (see image bottom).

- Here is an example using my

- current paragraph:

 Ihaveitsetto one character for :
- the demo, but you can also use :
- more, to highlight the whole Ffirst
- word, if you would like. If you pair
- this up with a snazzy font, the

ETELTET

Cwtlime & Lisk Tabs
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LibreOfFfice Drop Caps

results can be quite pleasing!

However, there are many ways

- to skin a cat, and a quicker way
- would be to highlight the
- paragraph you want to target, then
- using the right-click to display the
. - context menu, and then mouse-
- over the word “paragraph >" to
- display the word “paragraph ...",
% and click on that.

: And that is it, for our first

- LibreOffice short. If you would like
: more, let us know; if you think this
- is a waste of time, also let us know
- sowe don't use space in the

- magazine that could be used for

- something else.

misc@fullcirclemagazine.org

h contents



https://www.heise.de/en/news/From-Word-and-Excel-to-LibreOffice-Danish-ministry-says-goodbye-to-Microsoft-10438942.html
https://abcdefridays.blogspot.com/2014/09/drop-caps.html
mailto:misc@fullcirclemagazine.org

HOW-TO

Written by Erik

G odot works great on Ubuntu; if
you are using the Steam
version or the downloaded binary,
it does not matter, it runs fine. We
looked at the menus in the last
issue, now let's look at the lower
part of the interface. I'll be
referring to the DEFAULT layout. If
you have moved yours about, just
pay attention.

In this issue, we will be looking
at the bottom portion of the Godot
interface. It is important that you
know where to look for things,
before you start to make your
application or game.

The Ffirst thing you may notice is
the list at the bottom of the screen,
“Output”, “Debugger”, “Audio”,
“Animation”, and “Shader Editor”.

were to add a print statement to
my code, the output would appear

- here. In my case, you can also see

- that | added a “Label” node (image
- from the last issue) and then

. deleted the node. To the right of

- “4.4.1.stable”, we can see a pinicon
- and an icon with two arrows going

- up. This arrow icon expands the

- output, so one can see what is :
: happeningin real time; for example, :
- I wanted to make a “Pang!” clone
- and was experimenting with a

- bouncing ball and a brick or glass

- platform or whatever “Pang!” had,
- so every time the ball “hit” a

- platform, I would print “boing!” to
- the console to seeifit didit, every
- time, on every platform, so | could

- entered” (more on that in the

- GDScript issue). You can see how
- quickly the space would fill with
- “boing!” being printed over and

- over on a new line. Pinning the

- bottom display would make it
Outputis asitsays on the tin. If | :
" times when Godot auto-hides this

visible at all times, as there are

panel.

I'm going to skip the debugger

The audio tab is where you

" control the way your audio behaves.
- “SMB". Those are for “Solo”, “Mute”

- and “Bypass” (bypass still does all

- the work, but does not play the

- sound). This should already have

- the gears turning in your head.

- Usually it is not a good idea to add

- effects directly to the master, add a
- bus, add the effect and pipe it to

- the master. This gives you finer

- control when it comes to getting

- your sound “just right”. If you added
- a bus you don’t need, simply click

- on it and hit the delete key. You can
- also do that via the vertical ellipses
 next to “SMB”. The nice thing is that
- when you create a cool combo, you
- cansave itand use it in other

We can add a bus with the “Add

: : Bus” button at the top. Every time
© see a bounce via a signal, with “area :

- you add a bus, it will link to the

- previous bus. When you open the
© tab, you should see a “Master” bus
- that connects to the speakers. Now :
- if I were to add another bus (you

- can name it whatever you like, say
- effects), you will see that it does

© not connect to the speakers at the
" bottom of the bus, but it will chain

to the master bus (easy way to
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. remember this is that you can only
- ever patch left, not right). This

- as it will be a 1000 words by itself!:) :
‘ I'll see how it goes when | reach the @ you control the sound in the game,

- end of the article.

makes a “choke point” that helps

- say the master volume or music
- volume or sound effects volume
- and so forth, but we will get to that

in the future. Let’s talk about

projects, as it saves in the .tres

© format, and that is portable

- between projects. You can also drag
- and drop audio buses to move them
- in the chain, they are not static.

At first glance, the animation
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tab is rather empty.

It only comes to life, once you
have animations.

I'm lightly going to skim these
and we can dive in a bit deeperin a
future issue, as with the debugger,
it may require an issue on its own.
Needless to say, you can see the
panel come alive with more things,
once you start adding sprite sheets.

As for the “Shader Editor”, we
will also skip that for now, as it

* merits more space than this issue is
- going to give. Just know that it will
- also be bare if you were to open it

- on anew project. Go ahead, have a

- look.

Now there are two more menu

- items that are not displayed unless
- you have the nodes for it in your

- scene tree, they are “TileSet” and

- “TileMap”:

: | have trouble remembering
: which is which and | really hope
- they update the names soon.

The tilemap is your base, and it

- contains the actual tile map. It lets
- you set up tiles, patterns and
- terrains. The tileset is the subset of

the tile map that you will be using,
as you don’t need to use it all, if you

don’t want to. You could download
a whole tilemap from

- OpenGameArt, for instance, but

- you want only a small part of the

- tiles, not all. However, you do not

- paint on the canvas from here, even
- though you can clearly see a “Paint”
“icon. You do that, when you select

- tiles on the tilemap and use *that

- “paint” icon. Yes, | know, very

- confusing! Again, we will dive into

- these in a future issue as things will
- require quite a bit of explaining. |

- just want you to know that if you do :
 not see them, it's no big deal, it just
" means that you do not have a :
- tilemap node in your scene tree and :
- you did not click on it (that last bit is
- important, as just having it will not
- display them).

For allits improvements in the

© 4.x.x branch, I still get confused, as |
- still consider myself a n0Ob. This

- will happen to you too, don't fret,

- we will puzzle it out together!

Let me circle back to output

- (first image), you will see there are

- icons in the top-right. To clear the

© output, you use the paintbrush
“icon. Yes, a bit counter-intuitive, |

- know... However, directly below the
- paintbrush, is the collapse icon, that :

“Folds up” all the same-y errors,
making it easier to read your output
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log. I'm going to skip the copypaste
and search icons, they are self

- explanatory. What I am going to

- talk about are the four toggles

- below that. These toggle the type
- of output you will see in that

- message window. You can think of
- these like log messages, starting

- from the bottom again...:) Think of
- them as informational, then

- warnings, and then errors, and you
- turn on the level you need, so that
- you are not overwhelmed by

messages when you are trying to

- figure out what went wrong.

NOTE: In my screenshots, you
may see a bar at the bottom for

§ searching, but you may not see it on
- your version, that is because the

- little magnifying glass icon is

- pressed in mine, sorry | forgot mine
- Was on.

There you go, now you know

- why you may not see x ory, when

- following along a tutorial on Godot.
- Hopefully | helped you with any

- confusion. Don’t be like me and

- download a different version, to

- find out *why this or that panel is

- not there. Stick to the latest

- versions as there are nodes that are

being deprecated, so there is no
point in getting an old version.
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A quick word on the Steam have a metered network, the direct  these panes and panels work in a as I've hit my 1000 word limit
version — that downloads and download of the binary is like future issue, when we explore already.
installs Flatpak, so if you suddenly : 120MB versus the 1.2GB that - GDScript. Learn to know whereto
have flatpaks installed and . Steam installs. - look and identify the ones that : Comments to:
updating and did not want it, that is - confuse you. We can go over the - misc@Ffullcirclemagazine.org
the reason. That goes doubly if you We can get into more of how . parts we skipped in the next issue

i)

Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine sized
hard drives with multimeters and
oscilloscopes, laying cable, to scaling
Debugger Audio Animation Shader Editor 1.4.1.51 3G towers, he's done it.
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Written by Robert Boardman

A nother month has gone by and
another FCM has been
published. This time | am going to
work with a few of the many
packages under the “P” topic at
ctan.org. There are around forty

| had no trouble finding a few that
will work, and that seem useful to
at least some of you who read this
column. As usual, | will ignore topics
for languages. This includes:
Persian, Piedmontese, Polish and
Portuguese. | will also exclude any
packages which are not part of the
default installation of Latex.
Remember there are over five
thousand default packages so this
restriction is not very limiting.

In the Page Select topic, there
are three packages which can
control the pages that will be used
in the final document. The pagesel
package allows for all pages to be
“printed” (the default), or just odd
numbered pages, or just even
numbered pages, or specific pages.
Page selections can be made using
the same syntax that is commonly
used when printing to a printer:
comma-separated page numbers, or

- dashes to indicate page ranges.

: These can be combined. The

- examples from the documentation
- show [1, 4, 9], [7-10,3], [odd,3-6], [-
- 4,3,even,7-8]. The last two

- examples indicate the priority of
different topics starting with “P”, so : :
- numbers. [odd,3-6] prints 3and 5, [- :
- 4,3,even,7-8] -4 indicates pages

: from the start to page 4 so 3 is

- included, but even indicates only
- even numbered pages will be

- printed, so pages 2, 4 and 8.

the key words over specific page

Selecting pages for printing

- before the PDF is compiled means

- steps in the compiling process that
- rely on page numbers will be

- affected. Tables of contents,

- indices, cross-references,

- footnotes, end notes, etc, will all be
- affected.

Page section tools could be

- useful to hide information from

- viewers of the final document. For
- example, a teacher might find it

- useful to put all the questions for a
- test on odd-numbered pages andall :
© the correct answers on even- :
" numbered pages.

There are two other page

- selection packages, selectp and

- selectpage. Both were uploaded to
: CTAN in 1987. | suggest you use

- pagesel from 2020 if you want to

- experiment.

There are twelve packages that

- will allow text to be typedin :
- parallel columns. These are usefulin :
- scholarly publications for

- translations or for adding

- commentary to text. The paracol

- package by Nakashima and Kurtz

- has 315 pages of documentation

- plus a 64-page user manual. The

- documentation is written using the
- package. One column is English and
- the other is the Latex document

- used to generate the English. If

- nothing else, this is quite a feat of

- writing. | suppose it could be

- argued the actual documentation is
- only half of 315 pages. However |

- find it very helpful if the

: documentation shows both the

* Latex code and the result of that

- code.

The way to get started is to put

| usepackage{paracol} in the

preamble. Then start the document
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- and start with the command

- begin{paracol}{2} to generate two

- columns. (It is just as easy to set up
- and use more than two columns.)

- The command to move from one

- column to another is switchcolumn.
- Switchcolumn can also have a

- number as an option in brackets. If
- no numberis indicated, then the

next input will be placed in the

- column that is next. For example,

- starting in the left column, the

- switchcolumn command

: automatically moves the next input
- from left column to right column. If
- currently in the right column, then

- the nextinput goes into the left

- column.

Switchcolumn followed by an

- asterisk (*) will synchronize the
- columns, matching the length of
- text to the longest column in the
- input block before the asterisk.

Graphics, tables and other

- features may be incorporated into
- the switchcolumn environment.

- These features are set up as floats
©in Latex. You may need a few

iterations in order to understand
how to use them in a column
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environment, especially if the
floated items require more than
one column of horizontal space. If
this package sounds interesting to
you, | suggest you read the User
Manual and work through some

examples yourself. | have generated
a little example which accompanies :

this column. | used some
paragraphs from the beginning of
this article, and used LibreOffice to
translate them into French. The
code is shown (right) with this
article. | removed most of the text.

The paracol package is intended
to be used by academics. Many
packages in Latex do not have

serious intentions. For example, the :

shapepar package is designed to
bring some levity to documents. It
allows the user to typeset text to a
particular shape instead of a
standard paragraph with flush left,
ragged right and left indent. The
example shows the first paragraph
in a circle. There are other possible
shapes and other possible options.
The shapepar package can show a
shape with a cutoutinit. The
thirteen-page document is

somewhat long on technical details, :

and somewhat short on practical
use. There are two examples of the
creative use of shapepar but no
code to go with them. A close

\usepackage{paracol}

\usepackage[french, english] {babel}

\begin{document}

\section*{Welcome back}

\begin{paracol}{2}

Another month has gone by and another FCM
As usual I will ignore topics for languages.

\switchcolumn

Un autre mois s'est écoulé et un autre FCM a

Comme d'habitude,
\switchcolumn

\section{Page Select}

j'ignorerai

été publié.

les sujets relatifs

In the Page Select topic there are three packages....

\switchcolumn

Dans la rubrique Page Select,

\switchcolumn*

Page selections can be made using syntax...
The last two examples indicate the priority of the key words...

\switchcolumn

Les exemples de la documentation montrent [1, 4, 9],

6], [-4,3, pair,7-8].
etc.

reading of the documentation plus

some (many?) practice documents
: would help a user understand how

to use shapepar effectively. This
package is obviously not meant for
pages of technical or educational
documents. It would be fun for
invitations, diplomas, certificates
and other documents with small
quantities of text.

Returning to educational
packages, would you like to be able :
to add illustrations of atoms to your :
chemistry and physics homework?

. The bohr package adds the ability

to draw Bohr diagrams to Latex
documents. You may remember
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il existe trois packages

[7-101 3] ’

[impair, 3-

Welcome back

Another month has gome by amd an-
other POM has been publishod. This
timr 1 o godng vo work with w fow
of the many packages under the “P
topic at ctan.org. There are around
forty different topics starting with P
so | should have no trouble finding o
ferw thiat will work and that seem use-
ful to at least some of you who read
this column

As usual | will ignore topics for
Innguages.  This includes:  Persian
Pielmontese, Polish and Portiguese
I will also exclude any packages which
are not part of the default installs
thon of Latex, Hemembser there s
over five hundred difanll packages so

this restrictbon s not very lmiting

1 Page Select

Io the Prge Select topie there are three
packages which can control the pages
that will be used in the final do

wment. The pagesel packnge allows
: . A i i

Un autre ks s est doonls of un autre
FOM a éwd pubiliéc. Cotte foks, e vais
raviiller v U |q|-:||-- tds s g
breux packanges sous e sujot < P > sur
ctan.org. U existe une quarantaine de
sujets différents commengant par « P

1o e by e adoan Jos Ao e mal
i en trouver quokques-uns qui fone-
tionneront of qui sembleront utiles a
il misins certains o entre vous oui
livont oetie chrondguoe

Comumee o habitwde, jignorerai les
sujels relatifs anx langues. Cela in-
clut @ e persan, e pidmontais, le polon-
als ot e portugals, exchiral égaloment
tones les psckages oui ne font pas par-
tiee el Uinstallation par défmoat de La-
tese. N'oubliez pas qu'll existe plus o
cing conts packages par défaut, cette
restriction n'est done pas tris limita
tive:

Dans ln rubrique Page Select, il
existe trois packages qui peavent controle
les pages guil seront utilisées dans e
document final. Lo package pagesel

reerirned i st Dess puvevss o] ‘Slre o jon
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The element C - carbon. | t+ C

’ »
| |

The always poplar HF - hydrogen Houride :I il+ |1 ‘.. F- * *

\documentclass[pdf] {beamer}
\title{Practice Beamer File}

Bohr diagrams show atoms in “solar :

system” configurations with a
central nucleus surrounded by
electrons going around it like

planets around the sun. The current

version is limited to elements up to
atomic number 112. (Atomic
numbers, i.e. elements, are
currently at 118.)

The syntax is very simple.
usepackage(bohr) in the preamble
and then bohr{atomic number}
{atomic name}. The six-page
documentation gives several other
options to control the appearance
of each model. The package is not
limited to atoms. It can draw ions
which will show the distribution of
electrical charge in a compound.
Important Note: The user has to
supply appropriate correct values,

the package does not have a

- database with these values..

As you might imagine the P
topics include physics. There are

- many packages in the physics area.
- Packages for mechanics, optics,

- high energy physics, quantum

© theory, string diagrams, Feynman

- diagrams, thermodynamics, and

- more, are available. Some packages :
- are for specific institutions.

Presentation packages are also

- in the P topic. Tex/Latex is not

- restricted to PDFs which resemble
- books and journals. Tex/Latex can
. generate PDFs which resemble

- presentation files. The main

- package for this kind of work is

called “beamer”. There are more
that seventy packages available

\subtitle{for Full Circle Magazine}

\author{Robert Boardman}
\begin{document}
\begin{frame}
\titlepage
\end{frame}

\begin{frame} {Beamer Advantages}

\begin{itemize}

\item Generates slides
\item Uses Latex components
\item Generates PDF files

\end{itemize}
\end{frame}

- which either work with beamer or

- which attempt to make similar

- documents. If you need to generate :

- slide shows but have no wish to use

- a commercial package, | suggest

- you experiment with Latex Beamer. :
- guidance for beamer.

Beamer is a document class like

- article and book. The class was last

- updated in 2025 August. All (or

- almost all) of the packages

- discussed in these columns will

- work in beamer files. There is no

- need to learn a new set of

- commands simply because the

- document class is now a

- presentation. Because beamer files
- are Tex/Latex files, converting from
§ a presentation to a text document,
© or vice versa, is easy. The final

- output of a beamer document is a

PDF file which can be shown on-
screen, uploaded to a web site, or
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. given directly to participants.
. Documentation for beamer is

extensive: 234 pages. In addition to
the documentation available at

© CTAN, there are many other

sources of information and

| will explore the beamer class in

- one or more columns in the future.
- For now (above) is a code snippet

- and an illustration (top left) to get
- started.

Next issue | am going to explore

- modifying an existing package. As |
~ said in a previous issue | am not

- happy with the default formatting
- for the jwjournal package, so | am

- going to manipulate it in order to

. getajournal environment | like.
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t's an unwritten law of nature
that magazine deadlines and

software releases share a mystical

connection, such that when a writer :
states that an expected new
version has not yet been released, it :
invariably follows that the
statement will have been rendered
false by the time of publication.

Such was the case with my

statement, last month, that “there

is likely to be a 1.4.3 release,
though it will probably be mainly
bug fixes with few new features to
write about.”

Version 1.4.3 came out over the
festive break, but | was correct in
suggesting that it will be mainly :
bug fixes. Such a statement doesn't :
really do justice to the continued
hard work of the Inkscape
developers, with this release
including almost 100 bug fixes and
improvements —including a lot of
fixes for potential (and actual)
crashes.

There's an overview of the
changes in a news article on the
main Inkscape website
(www.inkscape.org) — but for a full

HOW-TO

list I recommend taking a look at
: the Release Notes in the Inkscape
- wiki: https://wiki.inkscape.org/wiki/

Release notes/1.4.3

- no new features that warrant much
- more discussion in this column

© (with one exception, which I'll talk

© about next month). Therefore, as |

. promised last time, I'm going to

- continue my investigation into the

© sort of tweaks and changes you can
- make via Inkscape’s ‘User...’

- directories.

Inkscape - Part 165

To avoid too much repetition, I'll

- assume that you've read last
- month’s article. That one, in turn,
- refers you to the article before

: that, so you've a bit of catching up

As expected, however, there are

" to doif you haven't read either of
- them. Suffice to say that we're

- looking at the directories listed in
' the ‘System’ pane of the Edit >

- Preferences dialog (below).

This month, I'm going to rattle

: through a few of the directories

- that | haven't yet covered, starting
- with ‘User extensions’. This is empty :
- for the vast majority of users, who

& Preferences

Q

v Taols Shared defaulk resources folder:

Syutem info

Usar preferences

¥ Interface

v Bebaviowr

b Input Gt pul

L User coafig:
Imported images
Rrrdering
Spellcheck

Ugar gxtrnsiors
User fants:

User themes:

LISEr G

User templates
Liser symisls

User paint servers:
Lisar palaties:
User keys

Lizar e

User cacke Jhomefav cache

dRcmen:

Jhomefsav) canfigfinkscape/preferences.smi

Rexet Preferences

B cpen
BEopen| B
B open |
B Ooen
B open
& Open
Bogpen
B3 Open
3 Coen
B Open

& Open
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- only use the default set of

- extensions that are shipped with
- Inkscape, but there are additional
- third-party extensions available

© which you may wish to install to

- your own directory, rather than

- making them available to all the

- Inkscape users on a machine.

In fact, the Inkscape project

: maintains a list of additional

- extensions at https://inkscape.org/
- gallery/=extension/-and it's well

- worth reading the information box

at the top of that page before you

- go adding any extensions. An

© extension is essentially an

- executable program that is

- executed by Inkscape and passed a

- Few pieces of information (such as

© the currently selected objects). |

. believe that, in theory, they could

. be written in any language -

- though Python is by far the most

© common. But, like any program you
© run, a rogue extension potentially

- has rights to alter or delete any files
- on your machine for which you have
© suitable permissions. Unless you

- run Inkscape as a superuser (don’t

do that), they're unlikely to be able
to affect any of the OS system Files
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—but deleting all your personal
photos, or exfiltrating your
‘top_secret_passwords.txt’ file to a
server somewhere on the internet,
are probably even larger concerns
for most desktop users. This is all
theoretical, and I'm not aware of
any malware having been shipped
via a third-party Inkscape extension
- but it still pays to be vigilant.

If you do read the information
box, you'll also note that it says
“Reviewed extensions can be
installed directly from Inkscape's
Extension Manager.” This is the
preferred way to go if you can, but

Please report this error

inkscape-extension-manager: 1.0

Mot done

X not be as expected.

- ‘reviewed’? Or what if the Extension
© Manager fails to open? | really wish

- this was a hypothetical ‘what if’, but :
- when trying to get a screenshot of
- the dialog for this article, all my

- efforts to launch it from the

- Extensions > Manage Extensions...
- menu entry resulted in this error

- (below).

least, even Reviewed extensions
g will have to be installed the manual
© way, so let's see what that entails.

Ctk-Message: 15:01:33.359: Failed to load module "xapp-gtk3-module”

Gtk-Message: 15:01:33.359: Failed to load module "appmenu-gtk-module”

Gtk-Message: 15:01:33.359: Failed to load module "canberra-gtk-module”
Semp/.mount_InkscaGglfML/usr/bin/. libflibc.so.6: version "GLIBC_2.38" not found {required by /
usrflibfxg6_64-linux-gnu/gio/modules/libgvfsdbus.so)

Failed to load module: fusrflib/x86_64-linux-gnu/gio/ymodulesflibgvfsdbus.so

Anerror occured with the extensions manager!

Trying to self-update the package... Failed to update!

Please delete the package manually! (see location below)

Report URL: https:ffaitlab.com/inkscape/extras/extension-manager/-fissues
Location: ftmp/.mount_InkscaGglfML/usr/share/finkscape/extensionsfinkman/finkman/finkman

Inkscape has received additional data from the script executed. The
script did not return an error, but this may indicate the results will

it's not always possible. What if the
extension you need hasn’'t been

The first step is to download the
extension to your local machine.

: Find one you like the look of on that
- wiki page, and click it to get to the

- Inkscape versions, and, most likely,

| guess that, on my system at

- some user comments. It's worth

- looking at those comments first as
- they may provide some insight or

- detail that will help you with the

- extension — or reveal to you thatit’s :
- not going to be useful in whatever
- task you're trying to achieve. And

- although the compatible version

- numbers can be useful, don’t take

- them at face value. An extension

- labelled as compatible with version
1.2 or 1.3 may well stillworkona
- 1.4 installation, even if not explicitly :
- flagged as such.

Having decided to download an

- extension, you need to unzip the
- content of the downloaded file into :
- your ‘User extensions’ directory. On :
- restarting Inkscape, you should
- hopefully find it somewhere in the
. Extensions menu structure. If it

doesn’t stand out immediately, you
can try searching for part of its
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name in the Extensions > Extension
Gallery... dialog. If it appears,

- selecting it will allow you to run it
- directly (via the Run button at the
extension’s details page. Here you'll
- find a download button (thoughiit's :
: not very obvious — look for the

- downward facing arrow, next to a
- number for the download count).
- Butyou'll also find a description,

- some tags that hint at compatible

bottom), but will also show you its
location in the Extensions menu to

the left of that Run button.

Not all extensions will run with

- all versions of Inkscape, on all

- machines, across all operating

- systems. There were significant

- changes in the extensions interface
- inInkscape 1.0, so any that were

- written for previous versions, but

© not updated, are unlikely to work

on more recent builds. Additionally,

- extensions may require specific

- libraries or other dependencies to

- beinstalled. In short, just because

- an extension is listed on the

- Inkscape website is no guarantee it
- will work for you.

| tried installing an extension in

- order to document the process: the
 “Instrument Scale Thumb”

- extension. | downloaded the zip

- file, extracted the contents into my

‘User extensions’ directory, then
launched Inkscape. Scouring the

© submenus, there was no sign of it.
- Even searching for ‘Instrument’ in
- the Extensions Gallery yielded no

results. Had | been a victim of a
system incompatibility?
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Looking more closely at the files
that | had extracted revealed a
Python file (‘render_scale.py’) and
an XML configuration file
(‘render_scale.inx’). Opening the
latter in a text editor, | found a
<name> element which contained

‘Scale’ near the top of the file. Near
the bottom was an <effects-menu>

element with a <submenu
name="Render”> entry as a child.
Sure enough, this extension that
was labelled as “Instrument Scale
Thumb” on the website appears in
Inkscape as Extensions > Render >
Scale.

As you can see, manually
installing extensions in this way
may sometimes require a little
additional effort and detective
work. Don't let that put you off
though —and, if you do get stuck,
asking questions in the Inkscape
forum may yield useful responses.
But if your Extensions Manager
does work, and you find the
extension you're looking for listed
in there, use that over manual
installation unless you have a very
good reason not to.

The third party extensions list is
fairly easy to find via the Inkscape
website —it's present as an entry in

the Download menu at the top of
the page. But once there, it's work

: taking a look at the ‘Media
: Category'’ list to the right of the

- page:
Media Category

Art K m
pediog 104
Photograph m

f pe Fil el m
Inkscape Temp File m
nkscape Custom Marker
nkscape Pattern File B

| ape Branding
Inkscape GUI I or set B
lor Palett m

fo o

Ul Mockup
P i
In Packags
Hackfe )
Earum Attachment m
Games Showcase a

You'll note that some of those
entries bear a close resemblance to
other directories in Inkscape’s user

config folder. Take, for example,
“Inkscape Filter Set”. As you can

: see, at the time of writing there are :
- only 20 entries in that category, but
- they're worth exploring anyway.

Downloaded filters typically

- consist of just an SVG file. It's

- nothing out of the ordinary —just a
- standard Inkscape SVG file much

- like you might create yourself. But
" the Ffile will contain SVG filter chains :
- and, usually, some objects with

- those filters applied. Opening the
- file in Inkscape will show the

- content, as you would expect.

filter to something in an existing
file as a one-off.
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But what if you do want to use it

- frequently? In case you hadn't

- guessed, just drop the SVG file in

- your ‘User filters’ directory and

- restart Inkscape. Any filters found

- in the files in that directory will

- appear in a new ‘Personal’ submenu
- within the Filters menu.

This also applies to your own

- filters. Have you created a filter

- that you want to reuse? Reduce

- your file down to just an object

- demonstrating the filter (or one for
- each filter in the file), save the file,

© and drop it into this directory.
This is actually a valid way to use :

- a filter file. You can delete the

- content if you wish but, so long as
- you don't use File > Clean Up :
- Document, the filter definitions will :
* remain in the document. Youcan
" therefore create a new element

- and apply one of these existing

- filters using the Filters > Filter

- Editor... dialog. This is a good way

* to use a filter as a one-off, if you're
- certain that you don’t want to use it :
- again and again. Copy-pasting an :
- element with a filter applied from

- one document to another will also
- copy the filter definition with it,

- which is useful if you wish to apply a :

Rl Extersions - Help

i mDeaws 28 BUT=B

ibar
ele y =k T -l A 15481 =g i
Bkt
Bump
Col ~ L] ,
Distont
Fill and Transparency v
i BT v
. -
v
.
e v
’, i ~

As an example, in the Elvie comic
strip that | co-create for Linux
Magazine, we use a very specific
drop shadow for the speech
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bubbles. By deleting most of the
content of a comic strip, and saving
a cleaned-up document containing
just a single speech bubble to my
User Filters directory, I've now got
easy access to this filter from the
Inkscape menus.

On the subject of speech
bubbles, Inkscape does ship with
some of its own, as Symbols. These,
along with a variety of other
symbols for flowcharts, logic gates,
map icons, and more, can be found
via the Object > Symbols dialog (see :
part 64 of this series, in FCM #124,
for full details about Symbols). But,
in case you hadn't guessed, you can
also add your own symbols to this
dialog via the ‘User symbols’
directory.

This works in a similar way to
adding filters. You need to create
an SVG file containing symbols — or
download one from the ‘Inkscape
Symbols Set’ category of the wiki,
much as we did with filters. Then
just drop the file into your ‘User
symbols’ directory and restart
Inkscape.

IF you're creating your own
symbols, there’s a step you'll
probably want to include, in order
to make the resultant file more

usable. That is to give your object a
title before you convertit to a

- symbol - the title will ultimately be
- used in the Symbols dialog. Here

- are the stepsin full:

-+ Draw your object. If your symbol

© consists of several separate parts,

: group them so that you're only

- dealing with one (group) object.

- » Open the Object Properties

- dialog. I usually right-click on the

- object and select it from the

- context menu, but you can also

- select the object first, then use the

Object > Object Properties... menu,

. or the Ctrl-Shift-O shortcut.

* In the ‘Properties’ section of the

- dialog, ensure that you give your
© object a human-readable name

. (preferably a fairly short one). :
-+ Make sure to click the ‘Set’ button :
- in the dialog before closing it, in :
- order to apply your change. You

© may need to scroll to find it.

-+ With your object selected on the :
- canvas, Open the Symbols dialog via :
© the Object > Symbols menu entry or
. the Ctrl-Shift-Y shortcut. :
-« Ensure that the ‘Current

- document’ category is selected in
© the pop-up menu at the top of the
- dialog.

- » Clickon the '+
- bottom of the dialog to convert

" button at the

your object to a symbol. It should
appear in the dialog with the name

- you wish to convert to symbols
- within this document.

* canvas will have been converted to
- symbols. Technically you could now
- delete them from your document,

- but | prefer to leave them in place

* as a visual example of each symbol
~in use. At this point you can tidy up
- the layout and optionally run File >
- Clean Up Document (don't do this if :
: you've removed the symbols from
. the page though, as unused

- symbols get cleared out). Finally,

- save the file into your ‘User

- symbols’ directory with an

you specified.
» Repeat for any other objects that

appropriate name. Note that this
name will be used as the basis for

: the Category name in the Symbols
- dialog, preserving the case but with

- the extension stripped. So a name

Note that the objects on the

- of 'Speech bubbles.svg" is much

* better than ‘symbols.svg’ (even if |
© do usually advise against spaces in
- filenames).

On relaunching Inkscape you

- should now find your custom
- symbols are present in the dialog,

and can be dragged into your page

like any other.

In case you're unfamiliar with

symbols, they're intended for use
. as-is, with just affine

Ssymhals s Wewancument

-
W symbals

Speech bubbles

~ 1 Fl
f:z-:'j-
bbbl

-

, 1 LY

Symbsol 2
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transformations such as scaling and
rotation applied. If you wish to use
the Symbols dialog as a library of
objects which you will further edit
once they're on the page, be aware
that you'll need to use Object >
Object To Path on each one to turn
them back into ‘normal’ Inkscape
objects.

That concludes our investigation
of the user directories. There are
others that you are welcome to
explore, though. For example,
‘palettes’ is a handy place to store
your own custom palettes, in GIMP
* gpl’ Format. And ‘fonts’ is

you want to use only in Inkscape -
though generally | recommend

installing fonts at a system level, or

INKSCAPE
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in your per-user OS-level font folder
(i.e. ~/.Fonts on a typical Linux

: machine), as there's a good chance
- you'll actually want to use them in
- another program at some point.

As mentioned in the previous

- articles, tinkering in some of these
- files and directories can break

- Inkscape, but, generally, you can

- just delete the new files you've

- created to get back up and running
- again. Therefore, so long as you

- exercise a little caution, you might
. find that Inkscape is far more

- configurable than you had perhaps
- realised.

sometimes useful for any fonts that

)

=

Mark uses Inkscape to create comics
for the web (www.peppertop.com/)
as well as for print. You can follow
him on Twitter for more comic and
Inkscape content:
@PeppertopComics
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L‘ Written by Moss Bliss

ant to personalize your Bodhi

Linux experience? Dive into  :
the world of themes! Bodhi offers a :
wide variety of themes to suit your :
style, from sleek minimalism to :
vibrant creations. While the wiki
covers the basics of installing and
using themes, let's explore some
simple commands to get you
started.

Listing Themes:

BODHIICORNER

about the theme package.

. Installing Themes

To install a specific theme, use

- sudo aptinstall followed by the

- theme's package name (e.g., sudo
- aptinstall bodhi-theme-moksha-

- dimensions).

If you want to install the entire

. ouse:

To see a list of available Bodhi

themes in the repositories, use:
apt search bodhi-theme

You can filter the results by
adding keywords after the search
term. For example, to find themes

with "green" in the name, use:
apt search bodhi-theme green

. Viewing Installed
Theme Files (Optlonal): likely includes settings optimized
: . for their appearance and

- Functionality.

- files a theme installs but this output - GTK Theme (Optional): Many

You can use dpkg -L to see the

. might be more useful for advanced

Theme Information:

To get detailed information
about an installed theme, like its

description and version, use:
dpkg -s bodhi-theme—-moksha-
green

. users.

Theme Anatomy: Unpacking

What Bodhi Themes Install

Think a Bodhi theme is just

. themes certainly transform the

The output will display details

visual appearance of your desktop,
they install several components

Bodhi Themes on the CLI

© that work together to create a
. cohesive experience. Here's a

- breakdown:

. » Moksha Theme: This is the core of :
* the theme, defining the visual style :
: of windows, panels, menus, and :
- other Moksha elements. It controls
- things like colors, fonts, and

- window decorations.

.« The Elementary Theme: This

- theme is built around the

. collection of Bodhi themes at once, Elementary Library (El,‘M)' a core

: - component of the Enlightenment

. sudo apt install bodhi-theme— : Foundation Libraries (EFL). ELMis

. pack - the toolkit used by applications like
- ePhoto and Terminology. The
- Elementary Theme reflects the

- default visual style of ELM apps and :

- Bodhi themes also include a

- matching GTK theme. This theme
- applies visual styles to standard

© GTK applications, ensuring a

- consistent look and feel across your :
- entire desktop.
- about eye candy? Think again! While thlgfnne?;?tné?\ (c?)[r)ntéo\[;/?t?{ Ecc)j_?tlom
~icon theme, replacing the default

icons with a set that complements
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the overall aesthetic of the theme.
: This includes icons for applications,
- folders, and system elements but is

optimized for older machines.

By installing these components

- together, Bodhi themes create a
- unified and visually appealing

. desktop environment. It's like

: getting a complete makeoverin
- one click!

. Beyond the Repos

Want to get even more granular

- with theme customization? The

- BodhiDev/Bodhi-themes GitHub

- repository offers a treasure trove

- of options. Here's how you can

. explore and potentially install

- individual theme components,

- rather than a whole theme package
- from the official repositories.

Each theme within the Bodhi-

© themes repo has its own dedicated
© folder. Within these theme folders,
- you'll find two key directories:

- DEBIAN and usr. The DEBIAN folder
- contains information used to

package the theme for easy
installation (not relevant to this
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method).

The real star of the show is the
usr/share directory. This folder
houses all the components that
make up a Bodhi theme. Here's
what you might find inside:
 doc: This folder contains
copyright and changelog files
related to the theme.
 elementary: This folder contains
the Elementary theme, which could
be a symbolic link to the Moksha
theme. Not all themes utilize the
Elementary theme.

* enlightenment: This folder holds
the core visual elements for the
Moksha desktop environment,
essentially the "Moksha theme"
itself.

« icons: This folder houses the

theme.

e theme: This folder contains GTK
themes that complement the
Moksha theme and ensure a

Important Note: Not all themes

above. It depends on the specific
theme's design and functionality.

Install Components
Locally

While the Bodhi-themes repo

- offers individual theme

. components, installing them

- directly requires some technical

- knowledge and can be a bit tricky.

Target Locations:

© « Elementary Theme: ~/.elementary :
-« Moksha Theme: ~/.e/e/themes/
.+ Icon Set: ~/.local/share/icons

- (Update the icon cache after

- installation using the gtk-update-
. icon-cache command)

. » GTK Theme: ~/.local/share/

. themes

Important Notes:

these settings in Moksha's Settings

Panel. There, you can set the
desired GTK theme and icon set. For

© the Elementary theme (if your

. theme uses it), you can use the

- elementary_config command.

-+ Icon Cache Refresh: When

- installing a new icon theme,

- especially on older machines, you

might experience a slight delay as

- Moksha rebuilds its icon cache. This
- one-time occurrence shouldn't

- impact performance after the initial :
- refresh or if needed a reBoot.

While directly installing theme

. components from the GitHub repo
- requires some technical knowledge, :
- it offers a unique way to
- personalize your Bodhi experience
-+ Symlinks and Elementary Themes: : W.Ith specific elements from
: . . - Many themes listed as "Elementary” : L L
custom icon set associated with the : - :
- themes are actually symbolic links
. pointing to the Moksha theme. In
. these cases, you only need to copy
- the Moksha theme edj file.
consistent look across applications .+ Missing Components: Themes
" ¢ often work together as a set, with
. the Moksha theme relying on
. . ) . . specific GTK themes, icon sets, or
might include every directory listed ~ even the Elementary theme (if
- applicable). If you only install the
- Moksha theme and not the other
. components, your desktop might

" appear incomplete. You can adjust

Compiling Bodhi
Themes YourselF

This section is for the truly

- adventurous themers! Compiling a
- Moksha theme from its source code :
- offers ultimate control and

- customization, but it requires a

- strong technical background and

- familiarity with development tools. :
: . Moksha might not yet be available

| Compilation Challenge: " in the official Bodhi repositories.
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To embark on this journey, you'll

© need to:

. » Clone the Theme Source: Use the
- git clone command to download

- the theme's source code from its

. Git repository (URLs are provided

- on the BodhiDev/Bodhi-themes

" repo).

-« Consult the Theme's Instructions:
: Each theme might have specific

build instructions or dependencies.

. Carefully review any

. documentation or README files

- included in the source code to

- understand the compilation process

and required tools. These details

- can vary significantly between
. themes.

A Word of Caution:

Compiling themes can be a

- complex process and might involve
- working with build systems,

© managing dependencies, and

- potentially encountering errors. A

theme's GitHub page might reflect

- ongoing development, meaning the
. code might have bugs or require
© the latest version of Moksha for full

functionality. This latest version of
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Written by Erik

N

You know, | just had a
conversation with an
acquaintance about a few scary

all movies, not just horror. This
person reads so much into a movie,
sees so much sub-text, whereas
moi, on the other hand, just sees
bad props and shallow storytelling.
This guy almost lives himself into
the movie, squeezing out every
drop and every crumb. | look at the
same movie and yawn and scratch
my butt; for me, a movie is face

me), distrust his colleagues for
anyone could be a monster - for
instance. | don’t live myself into this
person, and when he gets
eliminated, start living myself into
the next person’s feelings and
hopes and regrets, mainly because
it is not shown (and even when
things are supposedly “shown”, like
a cigarette in an ashtray, | don't
immediately leap to; “this person is
a nervous wreck with trust issues
and arrhythmia and abusive
parents”).

A book, on the other hand, lets
me make it all up in my head, the

- characters can be anything *I want
- them to be, not some director’s

© version, you don’t have to imagine
movies, but for me, it covers almost :
. the characters’ motivations. My

: thoughts then obviously switch

- over to the people on Reddit, who

- cannot see an apple in their mind's
- eye, and | worry that my “movie

© eye” may be dead, like these

© redditor’s minds? | watch a thriller

- movie and it just feels like lies and

- half-truths to me. The

- contradictions and omissions speak
value, it shows me a guy (who is not :
- series like some “whodunnit”, let

- say “murder she wrote”, is just

. escapism to me. | skim the surface

- like a water strider, because in real

- life, if you were to meddle in a

- police investigation, you'd be the

- one behind bars. It obviously does

© not help that the actual storyin a

- movie has to be cut to two or three
. hours, making it an abridged

- version of an abridged version of an
- abridged version of the actual book. :
: - KDE's control panel and Cinnamon'’s :
- settings or whatever, and every
© package manager out there, making :
* it boot slower, the application '

sometimes wonder about
- distributions that are out there,

MY OPINION

every crumb, as you get to read all

louder to me than the story itself. A

Long preamble over! |

that do not really add or subtract

(However, we are not here to

* talk about an operating system that :
- does not respect you, we are here
- to talk about Linux.) Then at the

- opposite end, we have distributions :
© that just Frankenstein it, the

- ramifications be damned! Using

- XFCE as a base, they add every

- framework out there and mix-and-
* match the things you use every day, :

like say Gnome’s file manager and

usage slower, and memory usage
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Some shower thoughts...

- anything to the “base” distribution
- and have none of their own

- innovations. | find Debian a good

- one to pick on, bear with me. A lot
- of the Debian-derived distro’s can
- actually just be a script — that you

: run after installing Debian. The

- changes are cosmetic, like

- customised start buttons or

- wallpapers. Somehow making it as
- shallow as Windows is, since Vista.
- There was a time you could run

. Litestep and truly customize

- Windows, but now, with Windows,
- you will own nothing and be happy.

- sky-rocket. | feel these distros have
" no clue and fumble in the dark. |

- don't want to talk about those, they
- are the kids who watch a Bruce Lee
- movie, then leave the theatre and

© immediately beat up a homeless

. person.

IFf we were to go to these Debian

© (respin) distros’ websites, we'd find

© mission statements or goals listed,

- and usually I'd find that it is nothing
- vanilla Debian does not already

* have. Mostly it equates to swopping
- out a few applications for

- alternatives.

Don’t get me wrong, XFCE (I'm

- talking about XFCE here, as usually
- the Debian-derived distro’s use it as

a base) is fugly by default (even on

© Debian), and some other desktop
. environments in pure Debian, has
. menu issues, etc, but with a bit of
. patience, XFCE is one of the most

beautiful customisable desktops

. thereis, that stays functional and

does not require editing hundreds

- of configuration files, like, say,

openbox.

If | compare say Xebian, Sparky,
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MY OPINION

Synex, AVLinux, MiniOS, Siduction,
WattOS, Muana, Kumander or
Netrunner, I'd be really pressed to
find honest innovations, original
programs (other than a few
welcome centres). I'm just naming
these off by hand, | haven't tried
most of them in at least a year, but
itis the idea I'm trying to put
forward here. Also... none of my
four Debian machines have a

Let me pick on Synex quickly as it
was the last one | installed. It says
“Focus on what matters: Solid
foundation, simple experience:
designed for businesses and users
who want to work without
distractions”. As well as: “About

Synex — Synex is an innovative Linux : :
- that, evenifitis sometimes not well :
© received. Other than trying to

. protect you with Snap applications,
- they also help you with things like

- Multipass, LXD, and more. (I believe
small and medium-sized businesses, :
- has their Cinnamon desktop going

- for them. | have respect for others

- like Devuan, who really getinto the
© guts and oppose systemd. If we

- look beyond Debian, to say, Void

- Linux, much respect to these

- pioneers, but with a small

- community and one maintainer, it

distribution crafted in Argentina,
built on the robust foundation of
Debian. Our mission is to deliver a
minimalist and stable operating
system that caters to the needs of

as well as individual users seeking a
straightforward computing
experience. We prioritize simplicity
without compromising on
performance, ensuring that our
users can focus on what truly
matters.”

Right, I installed Debian and
Synex side-by-side. Synex had an

“install” option that took you to the
live CD, where Debian had a true

- installer plus a live install. Once

- installed, the only difference I could
- find is that Synex removed some

- applications. What made it

- “business ready?” There were no

© "business” applications? No
shortcuts to set up LDAP, or a

- server or an accounting or invoicing
- program. Maybe it has an office
desktop, so I'm not very recent. Lol. :
: Maybe they have documentation on
© this? (Checks website...) Nope,

- installation guide only. Then what

© was the point?

suite with excel or calc? Not even.

Ubuntu is not just Debian-

- derived, they try their own thing,

you need to give them kudos for

the intentions are good). Linux Mint

will never be more than a “hobby”
operating system (too much

@
fiddling) with only a few

applications available to them. We

: can go extreme — Kolibri OS, an

amazing operating system that is

- Fast(!!) and small, but again, no
- applications and no big developer
: base, no real hardware support.

Juxtapose KaOS with what |

' have said, they focus on 64bit

- systems only, KDE and only the QT
- toolkit, giving you a much more

- unified experience, and developers
- build their own packages which are
- available from in-house

- repositories. This means it is

- excellent for home users, but

- cannot be used commercially orin

- the enterprise. They have chosen
- their market and aim to be the best :

in that market segment. If | were a

- normal home user, who did not

- need to learn new technologies for

- my trade, I'd probably use KaOS, as

- it seems focussed, and with clear
objectives.

Even on the Ubuntu side, there

- are distros with value added, like

- say, Voyager OS. They include their
- own scripts and small applications,
- and the overhead is on par with

- vanilla Ghome Ubuntu. Their goal is
- ease of use and customisation. |

don’t see a “new distribution” based
on say, Debian; | see re-spins, posing
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as new distributions. Are they
necessary? Do we just need to let

: them (the Debian respins) grow into
- their own thing? Do | have movie

- vision when it comes to these

- distributions? Do other people see

- Ubuntu as a Debian re-spin? Is

- innovation even a thing any more?

- There seems to be more of a rush

* to re-write things in Rust than there
- is to innovate, or is it just my

- imagination? It just turned August

: 2025 (this may only go out next

- year), and all | see is Rust this, Rust

- that, but Ubuntu still does not have
. a decent PDF reader compatible

- with Acrobat, but it is positioned as
- an enterprise OS?

What do you think Ubuntu

- needs now? Is it a roadmap, is it

- better configuration applications, is
- it hardware compatibility? Is it to

- worm themselves into AMD and

- Nvidia and smash that “code that

- cannot be included in Linux” horse

- manure and get Linux to be a viable
: option to Windows in the gaming

- space? Is it more creative

- applications, like cakewalk or

- whatever? Let us know your

- thoughts on

- misc@fullcirclemagazine.org
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HOW-TO

Written by Ronnie Tucker

GUIDELINES

he single rule for an article is

that it must somehow be
linked to Ubuntu or one of the
many derivatives of Ubuntu

RULES

* There is no word limit for articles,
but be advised that long articles
may be split across several issues.

* For advice, please refer to the
Official Full Circle Style Guide:
http://bit.ly/fcmwriting

« Write your article in whichever
software you choose, | would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

* In your article, please indicate
where you would like a particular
image to be placed by indicating

or by embedding the image in the
ODT (Open Office) document.

* Images should be JPG, no wider
- than 1200 pixels, and use low
- compression.

* Do not use tables or any type of
- bold or italic formatting.

(Kubuntu, Xubuntu, Lubuntu, etc).

If you are writing a review,

please follow these guidelines :

When you are ready to submit

your article please email it to:
articles@fullcirclemagazine.org

. TRANSLATIONS

If you would like to translate Full

- Circle into your native language

- please send an email to

. ronnie@°Fullcirclemagazine.org and
- we will either put you in touch with
- an existing team, or give you access
© to the raw text to translate from.

- With a completed PDF, you will be

. able to upload your file to the main

the image name in a new paragraph : Full Circle site.
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Write For Full' Circle Magazine

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

title of the game

« who makes the game

s isit free, or a paid download?

« where to get it from (give download/homepage URL)
* isit Linux native, or did you use Wine?

« your marks out of five

« a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

« make and model of the hardware

« what category would you put this hardware into?

any glitches that you may have had while using the hardware?
* easy to get the hardware working in Linux?

« did you have to use Windows drivers?

« marks out of five

« a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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REVIEW

Written by Adam Hunt

D uring each set of Ubuntu
releases, | normally look at
Ubuntu Unity, but this time there
was no Ubuntu Unity 25.10 release

due to some last minute unsolvable :

problems. Left r.ne.wit.h an opgning, © out only a year after Ubuntu's first
so | decided to fill it with a review of : release and Edubuntu became one
© of the earliest official flavors, after

had a look at this distribution was in : Kubuntu. The project was founded

FCM#005 back in September, 2007, - o 5liver Grawert and enlisted a

: team of developers aiming to

- provide a stock Ubuntu desktop (at
- that time using GNOME 2 and later
- using Unity) along with a suite of

- preinstalled educational software.

. The distribution was intended to

stacks up for school use and also as © enable nontechnical teachers and

Edubuntu 25.10. The last time we

so a fresh look is long overdue!

Edubuntu is an educational-
focused Linux distribution with an
interesting history. | thought it
would be worth seeing how it

a general-use desktop distribution.

Like the other official Ubuntu
flavors, Edubuntu 25.10 came out
on 9 October, 2025. After the third
and final interim release in this
development cycle, the next

version will be Edubuntu 26.04 LTS,

scheduled for 23 April 2026.

This is Edubuntu's 20th

anniversary of its first release, 5.10, :
"Breezy Badger". Because thisisan :

interim release, 25.10 will be
supported for only nine months,

until July 2026.

Background

Edubuntu's first release came

raa@BEBBIeErl Rl &CE)

- other school staff to easily set up a
- computer lab.

After its first release, 5.10, in

© 2005, Edubuntu went on regular

- six-month releases for eight and a
- half years until 14.04 LTS. For one
- release, 8.04, it was replaced by

- Ubuntu Education Edition, which

- allowed adding the educational

- packages on top of any existing

- Ubuntu installation. That idea was
: not a success and Edubuntu came
- back with 8.10.

The project had been losing

- momentum by the time 14.04 LTS
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Edubuntu 25.10

© was out in April, 2014, and the

- departure of developers Jonathan

- Carter and Stéphane Graber to

- other projects hastened that. The

" next plan was to start putting out

- only LTS releases every two years in
- order to save on labor, aiming for

© 16.04 LTS as the next release. That

© 16.04 LTS release was never made

- and 14.04 LTS proved to be the end
- of the line for Edubuntu for the

* next nine years, with the project

© abandoned.

It was while attending the

© Ubuntu Summit 2022 in Prague,

© Czech Republic, that husband and
- wife team, Erich and Amy

- Eickmeyer of Ubuntu Studio fame,
- decided to see about resurrecting
- Edubuntu with blessings from

: Canonical. Amy brought her

- experience as an early childhood

- educator to the project, and today
- sheis the Edubuntu Project Lead,
- part of a team that also includes

- her son, Jonny Eickmeyer, as lead

- student advisor.

Relaunched two and a half years

' ago with Edubuntu 23.04, the

project aims to provide the Ubuntu
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REVIEW

desktop core plus educational
software that can be selected for
school groups by age on
installation.

Edubuntu 25.10 is now the fifth
release that has been put out by
the Eickmeyer team. This version is
being advertised as "The 20th
Anniversary of Edubuntu" but, to
be fair, there were no releases for
nine of those 20 years.

Installation

| downloaded Edubuntu 25.10
from the official source using
Transmission to retrieve the
BitTorrent. | next carried out an
SHA256 sum check to ensure that

]
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the I1SO file download was good,

which it was.

This release's ISO file is 6.8 GB,

- making it the biggest Ubuntu flavor
- in size | have looked at so far and

- 1.1 GB bigger than the mainstream
© Ubuntu 25.10 on which it is based. It :
- will become apparent later on :
. where that 1.1 GB comes from.

| tried out Edubuntu 25.10in a

- live session from a USB stick using
- Ventoy 1.1.07. Edubuntu is not

- listed as being officially supported
© by Ventoy but, because it is based
- on Ubuntu, it works just fine.

. System requirements

CromgalléeeEsbalscE!

The recommended minimum
system requirements for Edubuntu

- 25.10 are:

: 1.2 GHz Dual-core processor or
- better.

- 4 GB RAM.

- 25 GB of free hard drive space.

16 GB USB drive for flashing the

- installer.

- An internet connection is

- preferable for installing additional
- software.
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New

Being based on Ubuntu 25.10

. means that Edubuntu 25.10 uses
 the GNOME 49 desktop and

- incorporates all of the changes that
- Ubuntu 25.10 brings, including

- using Wayland only for its display

. server. There is no X11 session any

. more.

This release replaces some

. previously used applications as
This means that Edubuntu 25.10 :

- should run well on any hardware

- designed for Windows 7 or later,

- although I suggest at least 8 GB of
- RAM as a working minimum

- especially for web browsing.

described below and adds more

© games, as recommended by the

. project's lead student advisor. It

- also adds gm-assistant, a package

. to assist in setting up and managing
- role-playing games, including

- Dungeons and Dragons.




REVIEW

Settings

Because it uses the same
desktop, the settings are generally

Edubuntu 25.10 does include 29
wallpapers, with many of them
classroom-themed (chalkboards,

Questing Quokka release.

Applications

The applications included with
Edubuntu 25.10 from the Ubuntu
25.10 desktop are:

CUPS 2.4.12 printing system*
Deja Dup 49.9 file back-ups
Firefox 143.0.4 web browser**
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GNOME Calculator 48.0 desktop
calculator*

. GNOME Calendar 48.1 desktop

© calendar*

the same as found in Ubuntu 25.10. : GNOME Clocks 48.0 clocks*

- GNOME Disks 48.0 disk manager*

. GNOME Disks Usage Analyzer

. (baobab) 48.0 disk manager

books, etc). Some of the wallpapers : GNOME Document Viewer (papers)
48.0 PDF viewer*

are quokka-themed since this is the :
 GNOME Files (nautilus) 49.0 file

" manager

- GNOME Image Viewer (Loupe) 47.0
- image viewer

- GNOME System Monitor 48.1

- system monitor

: GNOME Terminal (Ptyxis) 49.1

- terminal emulator :
© GNOME Text Editor 48.3 text editor
 GNOME Videos (totem) 43.2 movie

- player

g =
@ "
%
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®
Gparted 1.6.0 partition editor***

LibreOffice 25.8.1 office suite, less

- LibreOffice Base

. PipeWire 1.4.7 audio controller

- Rhythmbox 3.4.8 music player*

- Security Center (desktop-security-
- center) 0+git.d2e7fd4 security

- controller**

- Startup Disk Creator (usb-creator-
- gtk) 0.4.1 USB ISO writer*

- Systemd 257.9 init system

- Thunderbird 140.3.0 ESR email

- client**

- Ubuntu App Center 1.0.0 package
- management system**

- Wget 1.25.0 command line

- webpage downloader

: *indicates same application version §
 as used in Edubuntu 25.04
- **supplied as a Snap, so the version :

o ]
1B Full cirele

@ Full
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depends on the upstream package
manager

- ***included on the ISO for boot-up,
but not included in a full installation

Missing compared to the

© mainstream Ubuntu 25.10 default
- applications are:

- Archive Manager (file-roller) file

- archiver

: GNOME Document Scanner (simple-
- scan) optical scanner

- GNOME Snapshot webcam

- application

© Remmina remote desktop client

- Shotwell photo manager

- Transmission bit-torrent client

The additional packages added

© over and above the Ubuntu 25.10

default applications are:
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REVIEW

Artha 1.0.5 thesaurus*

Atomix 44.0 molecule building
game¥*

BASIC256 2.0.99 BASIC
programming for children*
Blinken 25.08.1 KDE version of the
Simon memory game

Calibre 8.8.0 ebook reader
Cantor 25.08.1 KDE mathematics
application

Chemtool 1.6.14 chemical
structures drawing program*
Colobot 0.2.2 programming
strategy game*

Connectagram 1.3.8 word
unscrambling game

ConvertAll 0.8.0 units converter*
Dia 0.98.0 diagram editor*

Endeavour 43.0 personal task
manager*
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Fritzing 1.0.1 electronic design
software*

- Gamine 1.6 interactive game for
- young children*

- GCompris 25.1.1 Games for children :
- aged 2-10**

© GIMP 3.0.4 image editor

: GNOME Maps 48.7 map viewer

: GNOME Shell extensions 49.0

- desktop extensions*

: GNOME Weather 48.0 weather

- display*

- gm-assistant 1.2.4 game master

- assistant for role-playing games*
© Gobby 0.6.0 collaborative text

. editor*

: Gradebook 1.2 school grade

- tracker*

Drawing 1.0.2 drawing application*

Gramps 6.0.1 genealogical research

. program
- Image Magick 7.1.2.3 image

Sram@El
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manipulator
Inkscape 1.4.2 vector graphics

. editor
: Jigzo 0.6.1 photo puzzle game*

KAlgebra 25.08.1 KDE algebraic

- graphing calculator

© Kalzium 25.08.1 KDE periodic table
© tools

- Kanagram 25.08.1 KDE jumble word :
- puzzle

: KBruch 25.08.1 KDE teaching aid

- for fractions

- KGeography 25.08.1 KDE

- geography teaching tool*

- KHangman 25.08.1 KDE Hangman
- word puzzle

- Kig 25.04.3 KDE interactive

- geometry tool

- Klavaro 3.14 touch typing tutor*

- KLettres 25.08.1 KDE foreign

- alphabet tutor

>6\
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Kmplot 25.08.1 KDE mathematical
function plotter

© KTurtle 25.08.1 educational

. programming environment

- KWordQuiz 25.08.1 flashcard

- learning program

: Laby 0.7.0 Learn how to program
- with ants and spider webs*

LibreCAD 2.2.0.2 computer assisted

- design*

© Li-ri 3.1.4 toy train simulation

. game*

- Marble 25.08.1 KDE globe and maps
. program

© Mnemosyne 2.11 spaced repetition
- flash-card program*

© Pysio game 4.20.01 games package
- for kids*

: Rocs 25.08.1 graph theory IDE

- Scribus 1.6.3 desktop publishing*

- Stellarium 24.3 planetarium




REVIEW

program*

Step 25.08.1 KDE physics simulator
Sysprof 48.0 GNOME system
profiler*

TuxPaint 0.9.34 painting program
for young children*

Tux Typing 1.8.3 typing tutor
game*

Ulcc 1.0.2 teaching tool using
pictures*

Xball 3.1.0 bouncing balls
simulator*

* indicates same application version
as used in Edubuntu 25.04

** supplied as a Snap, so the version

depends on the upstream package
manager

As can be seen, thisis a very
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extensive list of included
applications, which accounts for

© that 1.1 GB of extra ISO file size!
- These applications can be selected
Tux Math 2.0.3 math game for kids* : on installation based on the age of

the students targeted.

Changes in the application mix

- for this release include that

- Thunderbird has replaced Geary as

- the default email client, due to

- Microsoft 365 account compatibility
- issues, and that the GNOME Music

- player has been replaced with

- Rhythmbox.

Conclusions

So does Edubuntu 25.10 meet

the aim of being a useful and easy

to administer educational operating
system for school use? | think it

- does. It would also prove helpfulin
- keeping older computers in service,
- plus the worthwhile goal of

- introducing students to the

- wonders of Linux.

Does Edubuntu make a good

general use operating system? It
- does and might be worthwhile as
- your children’s operating system for :
- home use, but for non-students :
- there is really no advantage to

- installing it over just mainstream

- Ubuntu instead. A lot of unneeded
- applications would have to be

- removed to employ Edubuntu as a
- general home desktop.

Overall, Edubuntu 25.10is a

good release, with much to offer a
: student or for use in a school
- environment.

. The next release will be the long :
- term support version to complete
- this development cycle. Edubuntu
- 26.04 LTS is expected out on 23

- April 2026.
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_External links

Official website:
https://www.edubuntu.org/

)

=

Adam Hunt started using Ubuntu in
2007 and has used Lubuntu since
2010. He lives in Ottawa, Ontario,
Canada, in a house with no Windows.
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Written by Adam Hunt

Pop!_0OS 24.04 LTS Stable

hristmas arrived a little early in
2025 for fans of the Ubuntu-

based Pop!_OS. In fact, it arrived on
. some well-earned Christmas
© vacation!

11 December. As had been
promised in a System76 post on
Bluesky on 29 October, 2025, the
long-awaited stable version with

the new COSMIC desktop came out :
- here, able to be ordered for

- delivery on new System76

- hardware, but also available for

justin time for Christmas.

Perhaps the biggest surprise in

this new stable version is that there
. truly free software.

are almost no surprises. I'll put it
this way: if you liked the beta
version then you will love the
stable. The main noticeable
differences over the beta are "no
crashes" - this stable does indeed
seem stable - and lower idle RAM
consumption, which is always a
good thing.

Background

The project by Denver,
Colorado-based Linux hardware
builder System76 to build a new

Linux desktop for its Pop!_OS Linux

distribution was announced in

2022. Almost four years later, it has |

now arrived, production ready. |

- suspect the in-house company
. development team thinks the

timing is Fortuitous, as they get

After seven alpha versions, plus
one beta, the stable release is now

download for anyone to use, asitis

Pop! OS 24.04 LTS is based on

~ Ubuntu 24.04 LTS which is still the
© current long term support version

of Ubuntu and will be until 23 April,

: 2026 —when Ubuntu 26.04 LTS is
- expected out.

This new release sports the new

. COSMIC Epoch 1 desktop, built

- using the Rust programming

- language, the Iced toolkit, and

© running on a modern Wayland

- display server. As of today, it is

- pretty much the state-of-the-artin
- the Linux world.

© Not to rest on their laurels, the
- System76 developer team notes,

- "the COSMIC Desktop will be

- continuously updated with new
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features and improvements after

- release”. In the past, it has received
- pretty much continuous

- advancements, much like would be
- expected in arolling release

- distribution.

Getting Pop!_OS

It is worth noting that Pop! OS

- is not just for System76 hardware

- but will run on a variety of devices.
- There are separate Pop!_OS

- download versions for general Intel
- and AMD machines, boxes with

- NVIDIA GPUs, ones with ARM

- architecture, plus ARM combined

© with NVIDIA.

As in the past, there are several

ways of getting Pop!_0S 24.04 LTS:

IF you were previously running

© Pop!_0OS 24.04 Beta then you will

- already have Pop!_OS 24.04 LTS

- Stable through the update process.
- There is nothing more you need to
- do.

If you are still running the

previous Pop! _0S 22.04 LTS then
- you will be offered an upgrade via

notification to Pop! OS 24.04 LTS in

h contents
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January 2026 or you can force it
sooner from a terminal with:

pop—upgrade release upgrade

Or, you can just download the
ISO file from the website today,

write it to a USB stick and do a fresh :
: MB larger than the Beta's 3.0 GB.

© These are relatively small files for a
- modern Linux operating system

- here in 2025, and half the size of

- Ubuntu 24.04 LTS upon which it is
places to get it besides on Pop!_0S. : based, which was 6.1 GB. In fact, it
It is available on several other Linux : is smaller than any Ubuntu “flavor”.
- As described below, Pop!_OS

- includes fewer user applications,

- which is one reason why it is

- smaller.

installation, which may be the
cleanest route.

If you like the new COSMIC
desktop there are also many other

distributions including AerynQS,
Arch Linux, Fedora, NixOS,
openSUSE Tumbleweed, BSD, and
Redox OS.

Installing

| downloaded the generic

version of Pop!_OS 24.04 LTS from
. the official source by https, as there :
- are no BitTorrents.

The ISO file was 3.1 GB, just 100
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For testing, | dropped the ISO
file onto a USB stick equipped with

- Ventoy 1.1.07 and booted it up

: from there. Pop!_OS is officially

- supported by Ventoy and it loaded
- without any issues.

System requirements

There are now official

Pop! _OS has never been

- particularly light on RAM usage.
© One of my previous complaints way :
- back with Pop!_OS 22.04 LTS was

b

=

L

&
-
=
-
-
-
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that its fresh boot idle RAM was 3.9
GB. Pop!_0S 24.04 Alpha 7's idle

- RAM was 4.3 GB, and the Beta was
- even higher at 4.7 GB. Operating

- with a few applications open

- quickly puts all of them over 10 GB
- of RAM,

This stable version is now down

to anidle RAM of 3.7 GB, a clear

: "recommended" specs for Pop!_0S - improvement, but 4 GB will barely

24.04 LTS which are "4 GB RAM, 16
- GB storage, 64-bit processor", but |
© think that RAM call is unrealistically :
- low.

© getyou started. In comparison, also
© running on Ventoy, Ubuntu 25.04

- and Ubuntu Cinnamon 25.04 both

- idle at 2.3 GB. In testing with a

- bunch of stuff open on Pop!_OS

© 24.04 LTS, RAM use exceeded 10

- GB, so0 4 GBjustisn't going to doit,

and 16 GB is the minimum | would

: recommend, with 32 GB a better

RENENERE NG
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performance option.

New

Other than reduced idle RAM
and improved stability, there is
actually very little new in Pop!_OS
24.04 LTS that users will notice.

The provided Linux kernel is the
updated 6.17, compared to the
baseline Ubuntu 24.04 LTS, which
originally came with Linux kernel
6.8. Pop!_OS's initialization system
remains as systemd 255.4, the
original version of systemd from
Ubuntu 24.04 LTS. Pop!_OS also
uses Mesa 25.1.5 open-source
graphics.

@® Full Circle
PORT0

Much developer effort seems to
have been expended on making

- desktop application tiling work

- right, and it does work well. Inmy
© testing, | have found that Pop! _OS's :
- tiling is not really of much value on
- smaller screens. Trying it out on a

- 1920 = 1080 pixel screen, it works

© fine with two application windows
- open, but the results are not good
- with five or more applications!

- Tiling may be something that is

- useful on a big screen or even on a
- multi-screen setup but it does not
: work well on most single screens,

- and most users will be better off

- with traditional floating windows or :
- perhaps multiple workspaces
- instead. By default tiling is “off” and :
- is controlled by an icon on the

panel.

. Settings

Pop! OS 24.04 LTS maintains its

- focus on maximizing user

© customization choices and that
- makes it very different from

- Ubuntu and much more comparable :
: to Kubuntu.

Most of the customization

- settings are found in the new

- COSMIC Settings manager which

- puts them in one neat and

- organized place. Some other

- desktops, like Budgie, could learn

: from this solution. A few specific

© items are hidden away in the panel
- icon menus, but are easy enough to :

o
o

[3
o 25
ey
.
o
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locate. There are still some
desirable settings missing though,

- like the ability to display laptop
. battery time and percentage
. charge remaining on the panel.

The settings provide a wide

- range of customization, including

© turning off the dock and removing

- anything on the panel, which are all
- individual applets. The dock can

. also be reconfigured almost any

- way imaginable, including placing it
- on any screen edge, changing its

. color, opacity, size, and shrinking or
- expanding it to the screen edge. It

- all works very smoothly.

In Pop!_OS there are only two

© window themes, light and dark, but

h contents A
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those should be enough to keep
most users happy. There are also
nine highlight color schemes for
each of the light and dark themes.
These not only provide selection
highlighting in application windows
but also frame the active window

which is helpful to identify which
window is active and gives the

can pick your own colors and save
them, too.

This stable release includes the
same seven wallpapers as the Beta
version had, all of them "space"
themed.

| think most users will be
impressed with the wide range of

POl eEEES R

user settings provided. They really
do make it easy to customize, so

©you can truly make the desktop feel
- like your own.

The COSMIC Desktop

(the so-called "active hint" feature), Environment

What sets Pop! OS apart from

oaEEE

Simple as it looks, the launcher is

really what you will use the most. It :
- allows viewing all open :
- applications, searching for

- applications to open, and also

- searching for files to open. It is

- simple, but it works. Especially

- when it comes to opening files; it

L ) . .~ can save a lot of time delving
© its progenitor, Ubuntu, is the newly :

desktop a "spacey" feel as well. You :
- written COSMIC desktop. The idea
. isthatit's supposed to provide a

- better interface, with improved

- efficiency and ergonomics than the :
: GNOME desktop. It does this with
- an improved workspace menu

- (Super+W), better applications

. menu (Super+A) where it is easier to :
- find things, and the launcher (Super :

- key).

- through the file manager, although :
- that option is always still available.
- |t does make the file manager less
- important, as you will use it less

- frequently.

These three menuing elements

.~ are not new, as Pop! OS has used

Purkgamr s

switcher to the point where they
are all pretty optimized.

It is hard to argue with this basic

- design: it works and it is quite

- efficient. When you factorin the

. customization options you quickly
. realize you can make it look and

- work as you want, although the

- "out-of-the-box" settings are

probably the best, once you get

- used to them.

Is there a more efficient or

Flexible Linux desktop? | don’t think
© so.

. Applications
them for a while now, but they have :
- been refined and even integrated

- with the "alt-tab" application

The applications included with

L ]
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Pop! OS 24.04 LTS are the same as
with the Beta and Alpha 7, with a
new version of Firefox as the only
upgrade:

Archive Manager (file-roller) 44.3
file archiver

COSMIC Files 0.1.0 file manager
COSMIC Media Player 0.1.0 media
player

COSMIC Screenshot 0.1.0
screenshot utility

COSMIC Store 0.1.0 package
management system

COSMIC Terminal 0.1.0 terminal
emulator

COSMIC Text Editor 0.1.0 text
editor

CUPS 2.4.7 printing system
Firefox 146.0. web browser
GNOME Disks 46.0 disk manager
GNOME Disks Usage Analyzer

(baobab) 46.0 disk manager
GNOME Document Scanner (simple-

© scan) 46.0 optical scanner

- GNOME Document Viewer (evince)
© 46.3.1 PDF viewer

- GNOME Image Viewer (Eye of

- Gnome) 45.3 image viewer

- GNOME System Monitor 46.0

- system monitor

- Gparted 1.5.0 partition editor

- LibreOffice 24.2.7.2 office suite,
- less LibreOffice Base

. PipeWire 1.2.7 audio controller

. Popsicle 1.3.3 USB writer

- Systemd 255.4 init system
 Thunderbird 128.14.0 ESR email
- client

- Wget 1.21.4 command line

- webpage downloader

As can be seen, the suite of

provided applications remains fairly
light. The desktop basics are all

. there but, compared to Ubuntuy, itis :
: not a very complete beginner :
- desktop suite. Obviously missing
- are a bit-torrent client, calendar, file :
- back-up utility, webcam, image :
- editor, photo organizer, and remote
- desktop client. It is, however, a
- good list for a more advanced Linux :
- user, at least as a starting point.

- Personally, I actually like this list of
~included applications as | would not :
- have much in the way of unwanted
- applications to remove and just a

- few things to add.

Application installations,

- removals and software updates are
- allhandled by the COSMIC Store
- which is simple enough to use and

works well. You can also use APT
from the command line, too.

Both the Firefox and

- Thunderbird versions provided are

the Mozilla binaries and not

- Ubuntu’s Snap format ones. Pop!

_OS does not use Snap files by

- default, although snapd can be

installed to facilitate using Snaps if

- desired. Pop!_OS s set up for the
- usual and expected .deb file

repositories, mirrored from Ubuntu.

- It also has Flatpak installed by

- default, although there are no

- actual Flatpak applications

- installed. Flatpak offers a few

- nonstandard Linux applications,
- such as the proprietary Google
: Chrome browser.
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The biggest shortcoming in Pop!
_0S 24.04 LTS remains the same as
in the Beta and Alpha 7 versions:
missing features in the core

but need more necessary features
before they will be Fully ready for
prime time desktop use. For
example:

« COSMIC Files 0.1.0 file manager
does not display disk space, has no
bulk file renaming, and does not
even give a count of files selected.
« COSMIC Media Player 0.1.0 is
lacking codecs for .mov and .mp4
files, although it will play .webm

ones. It offers to install the missing :
codecs, though. :
¢ COSMIC Screenshot 0.1.0 lacks a
countdown timing feature.

« COSMIC Text Editor 0.1.0 has

syntax highlighting that works, but
is still missing spellchecking. The

. Beta release notes promised

- "printing support in COSMIC Text
COSMIC applications. They all work, :
- candidate" but there was no :
- “release candidate” and there is still :
- no printing from the text editor.

Editor is planned for the release

All of these may one day

- become good applications, they just :
- need some more work to get them
© to a "feature complete" state. | had
- hoped they would be completed for :
. the stable version of Pop!_OS, but
- that did not happen.

Until these applications are

improved, there are many
- alternatives in the repositories that :
© can be installed in their place. |

o

tested both the Nemo file manager
and the gedit text editor and they

- work well on Pop!_OS. Personally, |
- would install gedit to get a text

- editor with spellchecking, printing
- and better syntax highlighting

options, at least until those are all

rolled out for the COSMIC Text
© Editor.

. Conclusions

The COSMIC desktop and Pop!

5 External links

Official website:
https://system76.com/pop/

OS 24.04 LTS have arrived, and it is :

- all pretty good: stable, highly

. configurable, slightly lighter on
. RAM, and very functional. If you
* liked the earlier Alpha and Beta
- versions, you will like this stable
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- version even more, as it is just more :
- stable, polished and a bit less RAM
*intensive. It is just the core COSMIC
- applications that need some more
- work to be as good as their :
- equivalents in other Linux desktops. :
- Perhaps we will see improvement
- by spring’s Pop!_0S 26.04 LTS.

8

Adam Hunt started using Ubuntu in
2007 and has used Lubuntu since
2010. He lives in Ottawa, Ontario,
Canada, in a house with no Windows.
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Q) LETTERS

If you would like to submit a letter for publication, compliment

or complaint, please email it to: letters@fullcirclemagazine.org.

PLEASE NOTE: some letters may be edited for space.
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Join us on:

o I
Ly

https://mastodon.social/
@fullcirclemagazine

E twitter.com/#!/fullcirclemaqg

linkedin.com/company/full-
E circle-magazine

ubuntuforums.org/
forumdisplay.php?f=270

FuLL CircLE NEEDS You!

A Without reader input

: Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We are
always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.

See the article Writing For Full
Circle in this issue to read our
basic guidelines.

Have a look at the last page of
any issue to get the details of
where to send your
contributions.


mailto:letters@fullcirclemagazine.org
https://twitter.com/#!/fullcirclemag
https://linkedin.com/company/full-circle-magazine
https://ubuntuforums.org/forumdisplay.php?f=270
https://mastodon.social/@fullcirclemagazine

Q2A

If you have a Linux question, email it to: questions@fullcirclemagazine.orq,

and Erik will answer them in a Future issue. Please include as much

W elcome back to another
edition of Questions and
Answers! In this section, we will
endeavour to answer your Ubuntu

questions. Be sure to add details of :
: that same sound settings, open up

the version of your operating

system and your hardware. | will try :
- orvideo. You should see the

© application pop up. For instance, if |
- fire up SMplayer, | will see “mpv”

: pop up. That is the underlying

- application, if that application’s

- volume is muted, in my case, mpv,

- SMplayer will be muted even if the
- volume slider is up all the way. If :
- however, you see the volume bar to :
© the right of the slider moving, your :
- output may be set to the wrong

. output, for instance HDMI, instead

[insert intro story here] . °°-" ™

to remove any personally
identifiable strings from questions,
but it is best not to include things
like serial numbers, UUIDs, or IP
addresses. If your question does
not appear immediately, it is just
because there are many waiting,
and | do them first-come-first-
served.

: I have been pulling my hair

out. Sound in Ubuntu 24.04
used to work. Suddenly, nada. |
have tried Celluloid now too, and
still nada. No sound in VLC, but the
sound test in settings plays sound

I'm using Ubuntu Gnome with
Wayland.

Compiled by EriktheUnready

:In Ubuntu, applications affect
each other, so if you have the

© sound muted in one, it may affect
- the others. | think we had someone :
- on here that muted VLC to find that

SMPlayer was also muted. Thus, in

“Volume levels” and play your audio

: How can |l install ONLY writer
and calcin LibreOffice. | don’t

: need the other stuff as | do not use
. them. This will be very handy to me

perfectly. With Windows, it's always please.

drivers, how do | fix Ubuntu sound?

: Surf to the LibreOffice
website and download the
compressed file. Uncompress it on

information as you can about your query.

your computer. Once
uncompressed, go into the folder
- and delete anything that says

noar

- “draw”, “impress” or “math”. You

can delete the KDE integration if

: you are on Gnome. You can also

- delete the dictionaries that you do
- not use. (Don't worry, you still have
- all those files compressed.) Now

* run the install command in the

- ‘readme’ file in your terminal

- (terminal has to be in the same

- folder). Voila! Even though menu

* jtems may say math or impress,

- they will not launch.

.1 tried to open a file in
LibreOffice and accidentally

: bumped my mouse, which caused
- the main window to move. This in
. turn moved my “open” window to
: go below my main window and |

: could not access it, causing my main :
- window to now be “frozen”, waiting :
: for me to select a file that | could

. not reach. | had to open the system
: monitor and kill it from there. How
: can | avoid this in the future?

: I had to translate your
question into English to fit the
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- magazine format and | took a few

- liberties. The short answer is that

© you cannot. This is a bug, the

- overlay window needs to be modal
- (I think that is the term), where it

© cannot move or go below other

- windows. Kindly log this as a bug on
- the LibreOffice forums.

:1am still on Ubuntu 24.04.2,
having switched with 20.04

- during covid, so I'm not your typical
: Linux enthusiast. Pinta just updated
. to a new version. | have updated a

: Few times now, but Pinta is not

- updating. How long will it take

. before | can get it?

: It may never(!); that is the
thing with updates. It may have

a dependency thatis not
: compatible with 24.04, or the

package maintainer may have
moved on to other things. You can

© wait, at the time of writing it has

- only been a few days. (Someone

- may need to test it before it gets

- accepted into the Ubuntu

© repository). If you are in a hurry and
" “must have” the latest version to,

say, fix an issue, you can grab
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the .deb Ffile directly from the
developer or you can compile it
yourself. However, if you have
problems thereafter, you would
need to contact the developer.

: Please don’t go all high and
mighty on me. | have somehow

| must use gksudo synaptic to fix
the error. When | try that, it says.
melanie@ubuntu:~$ gksudo
synaptic

Command 'gksudo' not found, did
you mean: command 'gfsudo’ from
deb gfarm-client (2.7.20+dfsg-
1build1)

Try: sudo aptinstall <deb name>

gfsudo, so please help.

A: Oh look at these peasants!
(ONLY KIDDING). | don't think
gksudo is in the repositories any
more. In your terminal, type the
following:

sudo apt—-get install -f£

and hit enter. Then follow the
instructions.

.l record sound with sound
recorder 43 beta to upload to a

. website to identify the tune. | can

. see the recording, it says Recording
: 1, and the length of the recording.
. This part is simple, but how do | get
: it out of the sound recorder onto a
. file, or upload it from there? There

. is no file menu in this application.
broken my software installer. It says :
- which is useless. <removeds. Also,
: why is it that when | record off of a
: youtube video, the sound is so

. hollow?

The only menu is the 3 stripes,

: When you click on the
recording to play it, it should

- expand, and on the bottom-right,

© there should be a downwards arrow
- to save the recording. Yes, it is

| don’t know my gksudo from my :
- note, there is an application
© (mouse.ai?) that can doit all for you,
- in one go. (I have not used it, but |
- read about it). Secondly, Sound

- Recorder uses your device

- microphone to record, if youwanta
- clean recording off YouTube, | :
© suggest you give yt-dlp a go.

rather unintuitive. Just on a side

.1 tried to install phoenix code
as per their website, with:

wget -qO- https://

updates.phcode.io/linux/installer.sh
| bash

It is supposed to be brackets

: enhanced, but it is something else
- that I don’t like. How do I uninstallit :
: now?

that there is an uninstallerin

the script, but I'm not sure how to
© access it. | suggest you ask the
- question on their forum.

: 1 have a question about the
“open with” dialogue in Ghome

- Ubuntu, please. When I click on a

: PDF, and | want to openiitin

: Zathura, rather than Evince, |

: choose, “open with” and hit the “Z”
- key to sort or bring up Zathura to

: the top of the search. When I do

. that, it shows me this <removed>

: (zathura with noicon), but when |

- scroll down, | find Zathura with the
- hash icon happily at the end? What
: is going on here?

: I suspect it has to do with
Zathura itself, as Zathura has a

- command line launcher as well (jirc). :
: - items, you can click on the missing

- items and it will tell you why
- (eg."Arabic end of text mark is not

:I'm really confused here. |

installed Chromium and set it as :

my default browser and
immediately blocked it from any
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network connections via my
firewall. This is so that applications

: that just open your browser and

launch a webpage without your say-

: so get no satisfaction. | use FireFox
: BTW. Then | noticed something in
-1 had a quick look, and it seems :
: have a blank line, when I click oniit |

. see snap.chrome and | get a broken
. password? If | copy the password

- and paste it in my text editor, it

. looks like this:

. BU\FE\9E\E8>\86\BF\B3q#\C38\A2\
| F52\88#\87;US\E6 #;

: \9EgjD\FBUE\E6#\CAVL\99\BB Ht
. EoC\y\<removed>\FD\ED#

Hl

passwords and keys. Under “login

Can you tell me why?

: I removed a piece of that just
in case. The short answer is

- that you have changed your font to
- one that does not have all the

- characters that are needed to

- display the password. Try

- Nerdfonts? Ubuntu Tweaks? Or, you
- have removed fonts that you do not
- use, like say, Chinese and Japanese

- or Arabic fonts. If you open the

Characters app and you see missing

included in Ubuntu Sans”).
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.1 bought a surplus laptop from

my company that is sold every 3

years. | installed Ubuntu on it and
wanted to make sure the battery is
still okay. The weird part is that it
displays multiple AC adapters but |
only have the one plugged in? Also

‘Energy when full’ is 55 and ‘Energy

design’is 85. Do | need to replace
the battery?

: Let me start with the battery.
Some settings only let the
battery charge to +-60% if plugged

in all the time to extend the battery

life. You would need to check that
in the UEFI/BIOS. I'd say 55/85 is
fair after three years of use. If you
scroll down, you should see

“Capacity”, if that drops below 40%,
it's time to get a new one. As to the :

AC adapter, | used mine as
reference, as | cannot say
otherwise, mine also has multiple
“AC Adapters” but that is because
mine charges via USB-C port and it

will list one for each. | suspect yours

is the same, listing USB-C ports as
adapters.
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Website:

Price: Free!
Blurb: “Endless Sky is a 2D space

the classic Escape Velocity series.
Explore other star systems. Earn
money by trading, carrying
passengers, or completing missions.
Use your earnings to buy a better

engines on your current one. Blow
up pirates. Take sides in a civil war.
Or leave human space behind and
hope to find friendly aliens whose
culture is more civilized than your

"

own.

ndless_Sky-v0.10.16-x86_64

was released the day before
yesterday and we just had to try it,
because this project has been
getting better by the release! (This
article may not hit the current
issue(s) as the October issue has
already been set.) However, when

you do read this, the context will be
just as valid as it is today. If you ever :

tried Escape Velocity, Naev or
Cosmic Frontier, you will feel at

UBUNTU GAMES

home in Endless Sky.

Installation:

The game is available as an

X e - Applmage at 343 MB and requires
trading and combat game similar to © noinstallation. You simply run the

- application and enjoy. (I think it

- was half the size of Neav nightly

- build, which was also released this
- week.) If you have Steam installed,

. - you can play it from there too.
ship or to upgrade the weapons and -

Graphics:

The first thing that may jump

- out atyou is just how gorgeous the

game looks. The graphics are crisp,
- even at 4K, and you can simply
- marvel at some of them.

Story:

Yes, this game has a story,

- woven by many internet story

- tellers and proofread by just as

- many users. This also means that

* this is not a game you can sit down
- and play for five minutes. You

- better put aside an hour or two

- when you approach this game.
 While the story won’t give you

- Firefly levels of intrigue, it is

- passable and engaging even with a
- twist in there. There is also realism
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Endless Sky

here, where the bank gives you a
500k loan with 500k in interest, to
- be paid back in a year.

They put it thus: “After years of

- working a factory job, you have

- finally saved up enough money to

- apply for a pilot’s license and make a
- down payment on your very first

. starship. The backwater planet

. where you grew up sells only three

- ship models: a shuttle, a cargo

- barge, and a light interceptor.

: Depending on which one you

- choose, you'll start out earning

- money by transporting passengers,

- looking for good trade deals, or

© perhaps mining asteroids or taking

- jobs escorting freighter convoys. Of
. course, you are hoping to save up

- enough money for a much better

. ship before long.”

SPOILER:
This is not the only story.

Gameplay:

I highly suggest that you head

© over to: https://github.com/

endless-sky/endless-sky/wiki/
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“manual” or wiki, before you even
start playing. Why? Keys... When |
first started playing, | put the game
aside, as it was so sloooowww. It
was only when | read the wiki, that |
found out about the afterburner
and how to jump to hyperspace. All
those space rocks that assault you
when you start? Read the wiki. It
will make your time with this game
worthwhile.

My first impressions were,
Freelancer / Privateer / Elite in 2D!

You start with a shuttle, Uber in

space, a freighter, basically a barge,

or a fighter, the space mosquito.
From here, you are given free reign
to explore the galaxy, undertake
missions and trade, defend or
plunder... your choice. The game
loop is simple, but solid. I haven’t
had any issues playing on Linux.
(Debian, Mint, Ubuntu). Physics
plays an important role in this
game, so you better get used to it.
The bigger your ship, the longer it
takes to spin up and slow down.

The best part is that you can buy

stuff for your ships that you can
bolt on. I'm not just talking guns
and missiles, though there are lots
of those too, but “systems” as the
game calls them. This freedom of

customisation is probably why *I
enjoy the game so much. If you

- want to make a space train (lots of

- fun, really), you can do that and the
. missions in the game seem to :
- mould around what you have. If you :
© go to a new place, like a planet,

- thereis usually a job board and this
- is one of the ways you can build

- reputation with that place.

© Reputation plays a big role in the

- game and you should not ignore it.
- As | said earlier, the missions mould
- themselves to your capacity, a nice

You paid 1,39

Entenng the

mechanism that stops that endless
scrolling for something you can

actually do, not just randomised
© missions.

You will be playing a while

: before the missions start to

- become recognisable and then a
- long time more, before they start to :
- feel same-y, so don’t worry. In the

- beginning, I'd play it like elite,

- where | keep pen and paper handy,
- as remembering names and places
- is not my forté. There are also

hague system on Tue, 11 Jan 3014
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factions in this universe and your
reputation with these matter too.

* You need to pay attention when

- reading what is happening, as you

- don’t want to be on the bad side of
- all of the factions in this game, that
*is, unless you are a pirate (space is

- large, so piracy can spawn

anywhere). There is, for instance,

- the free worlds group or the

- syndicate or the republicif you like
- to getinvolved in politics, but, |

- don’t want to give anything away, it
. is best experienced when you play
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for the first time. Obviously you can
pay the bank back in the first year —
but not with ferrying students —
there is a secret... OK, I'll level with
you, it's drugs. I'm not talking

names like “bad blues” and that is
why you start with the barge...

Now once you are comfortable
with the game, and you start to
notice some things recurring, you
need to head on over to: https://
endless-sky.github.io/plugins.html -
and see where that takes you!

But wait, there’s more! You can
extend the game even more with
mods.
https://www.nexusmods.com/
games/endlesssky
https://www.moddb.com/games/
endless-sky/mods

Star wars? Star Trek? Babylon 5?
New alien races? Pick your poison

and see where the rabbit hole takes
you. If you cannot find what you are :
looking for, there are guides to help :

you make your dreams come true.
(https://aithub.com/endless-sky/
endless-sky/wiki->and go to:
Creating ships, missions, artwork,
etc.)

For me, this is a game that keeps

on giving. It gets better every time
they update. If you like this kind of

- game, | suggest putting this one on
- your radar and hope we get to a

- version 1.0 soon!

pharmacy runs here, stuff that have :

If you want a more old school

- approach, you can always compare
- ASCll sector https://
- www.asciisector.net/, with this.

chokes.

. Conclusion:

: Go grab it, it's free, you may like
- it. Tknow I did!

Though you can play this on your

tablet. My suggestion is to play it on :
- your Ubuntu PC or laptop, because
: when your fleet grows, the tablet

)

=

Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine sized
hard drives with multimeters and
oscilloscopes, laying cable, to scaling
3G towers, he's done it.
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Ka tl.-ma - Frits van !_eeuwen The current site was created thanks to
Alex Crabtree : Kevin O'Brien : Randy Brinson Arun (from our Telegram channel) who
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Andy Garay : Lee Layland : Robert JEROME © rebuilding the site, from scratch, in his
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Several people have asked for a PayPal
(single donation) option, so I've added a
button below.

A big thank you to all those who've
used Patreon and the PayPal button.
It's a HUGE help.

https://www.patreon.com/
fullcirclemagazine

https://paypal.me/ronnietucker

https://donorbox.org/recurring-

monthly-donation
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" FCM#226
FULL CIRCLE NEEDS YOU! Deadline Webmaster - |
A magazine isn't a magazine without articles and Full Circle is no Sunday 08th Feb. 2026 admin@fullcirclemagazine.org
exception. We need your opinions, desktops, stories, how-to's, reviews, Release: . )
and anything else you want to tell your fellow *buntu users. Send your Friday 27th Feb. 2026 Ec!'t'“g & Proofreading
articles to: articles@fullcirclemagazine.org Mike Kennedy, Gord CampoellRobert

Orsino, Josh Hertel, Bert Jerred, Jim
We are always looking for new articles to include in Full Circle. For help and advice please Dyer and Emily Gonyer
see the OfFicial Full Circle Style Guide: http://bit.ly/fcmwriting

Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Send your comments or Linux experiences to: letters@fullcirclemagazine.org :
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org /
Questions for Q&A should go to: questions@fullcirclemagazine.org

Desktop screens should be emailed to: misc@fullcirclemagazine.org

... Or you can visit our site via: fullcirclemagazine.org

Getting Full Circle Magazine:

For the Full Circle Weekly News:

-‘\ You can keep up to date with the Weekly News using the RSS
LA L

LIJ EPUB Format - Most editions have a link to the epub file on
feed: https://fullcirclemagazine.org/podcasts/index.xml

that issue's download page. If you have any problems with
the epub file, email: mobile@fullcirclemagazine.org

back on Spotify:
https://open.spotify.com/show/6JhPBfFSm6cLENGSbYsGarP

and now on YouTube:
https://www.youtube.com/playlist?
list=PLnvOU8wWOzXu487ai5121sf-rQjEyKPAIf

FCM PATREON : https://www.patreon.com/fullcirclemagazine
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